<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>1</td>
</tr>
<tr>
<td>Product Overview</td>
<td>2</td>
</tr>
<tr>
<td>Function of the Logic Matrix</td>
<td>3</td>
</tr>
<tr>
<td>Installing</td>
<td>4</td>
</tr>
<tr>
<td>Software user interface</td>
<td>5</td>
</tr>
<tr>
<td>Configuring</td>
<td>6</td>
</tr>
<tr>
<td>Transfer Logic Matrix</td>
<td>7</td>
</tr>
<tr>
<td>Operator control and monitoring</td>
<td>8</td>
</tr>
</tbody>
</table>
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

⚠️ DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

⚠️ WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

⚠️ CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

⚠️ WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
Preface

Purpose of this documentation

The information in this manual makes it possible for you to configure with Logic Matrix.

Basic knowledge requirements

General basic knowledge of automation engineering is needed to understand this documentation. Basic knowledge of the following is also necessary:

- S7-400 Automation Systems
- PCS 7 basic software, particularly:
  - Working with SIMATIC Manager
  - Hardware configuration with HW Config
  - Communication between CPUs
  - CFC optional software
  - Good understanding of the type/instance concept of PCS 7 in the form of process tag types / control modules (Control Module Types; CMT)

Scope of this documentation

<table>
<thead>
<tr>
<th>Optional package</th>
<th>Order number</th>
<th>Release number and higher</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC PCS 7 Logic Matrix Tool, Software Media Package</td>
<td>6ES7658-1JA29-2YA0</td>
<td>V8.2</td>
<td>Without license</td>
</tr>
<tr>
<td>SIMATIC PCS 7 Logic Matrix Viewer, including license on USB stick</td>
<td>6ES7658-1JB28-2YA0</td>
<td>V8.2</td>
<td>Single, Runtime mode on one station</td>
</tr>
</tbody>
</table>

Position in the information landscape

Depending on the particular application, you will need the documentation described below to work with the Logic Matrix.

This documentation includes references to the supplementary documentation where appropriate.
Also refer to the FAQs on PCS 7 (http://support.industry.siemens.com/cs/ww/en/ps/16933/faq).

<table>
<thead>
<tr>
<th>Documentation for</th>
<th>Brief Description of Relevant Contents</th>
</tr>
</thead>
</table>
| PCS 7             | The PCS 7 manual describe the handling of the PCS 7 control system:  
|                   |   configuration manual  
|                   | ● "Operating Station (http://support.industry.siemens.com/cs/ww/en/view/90682677)"  
|                   |   configuration manual  

Guide

This documentation describes the use of the following add-on packages:

- Logic Matrix Editor and
- Logic Matrix Viewer.

The following topics are addressed:

- Configuring the Logic Matrix
- Transferring, compiling, and downloading the Logic Matrix
- Operator control and monitoring of Logic Matrix in PCS 7

Conventions

The term "configuring" used here corresponds to the term "programming" used in the referenced documentation.

Additional support

If you have further questions about the use of products presented in this manual, contact your local Siemens representative.

Your contact persons are listed in the Internet (http://www.siemens.com/automation/partner).

A guide to the technical documentation for the various SIMATIC products and systems is available in the Internet (http://www.siemens.com/simatic-tech-doku-portal).

You will find the online catalog and online ordering system in the Internet (http://www.siemens.com/industrymall/).

Training center

We offer courses to help you get started with the SIMATIC S7 automation system and PCS 7 process control system. Contact your regional training center or the central training center in D 90327 Nuremberg, Federal Republic of Germany.

You will find more information in the Internet (http://www.sitrain.com).
Technical Support

To contact Technical Support for all Industry Automation products, use the Support Request Web form (http://www.automation.siemens.com/support-request).

Additional information on our Technical Support is available in the Internet (http://support.industry.siemens.com).

Service & Support on the Internet

In addition to our documentation, our complete knowledge base is available online in the Internet (http://support.industry.siemens.com).

There, you will find the following information:

- Newsletters providing the latest information on your products.
- A search engine in Service & Support for locating the documents you need.
- A forum where users and experts from all over the world exchange ideas.
- Your local contact person for Industry Automation products is listed in the Contacts database.
- Information about on-site service, repairs, spare parts, and much more is available under "Repairs, spare parts, and consulting".

See also

CFC for S7 Continuous Function Chart (http://support.industry.siemens.com/cs/ww/en/view/90683154)

Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>3</td>
</tr>
<tr>
<td>1 Product Overview</td>
<td>11</td>
</tr>
<tr>
<td>1.1 What is the Logic Matrix?</td>
<td>11</td>
</tr>
<tr>
<td>1.2 Optional packages of the Logic Matrix</td>
<td>12</td>
</tr>
<tr>
<td>1.3 Definition of terms</td>
<td>12</td>
</tr>
<tr>
<td>1.4 Overview of procedure</td>
<td>14</td>
</tr>
<tr>
<td>2 Function of the Logic Matrix</td>
<td>15</td>
</tr>
<tr>
<td>2.1 Matrix</td>
<td>15</td>
</tr>
<tr>
<td>2.2 Cause</td>
<td>16</td>
</tr>
<tr>
<td>2.2.1 Analog input voting</td>
<td>18</td>
</tr>
<tr>
<td>2.2.2 Analog input deviation</td>
<td>18</td>
</tr>
<tr>
<td>2.2.3 Digital input evaluation</td>
<td>19</td>
</tr>
<tr>
<td>2.2.4 Signal status</td>
<td>20</td>
</tr>
<tr>
<td>2.2.5 Bypass</td>
<td>20</td>
</tr>
<tr>
<td>2.2.6 Timing</td>
<td>21</td>
</tr>
<tr>
<td>2.2.7 Degraded voting</td>
<td>21</td>
</tr>
<tr>
<td>2.3 Effect</td>
<td>23</td>
</tr>
<tr>
<td>2.3.1 Bypass</td>
<td>24</td>
</tr>
<tr>
<td>2.3.2 Override</td>
<td>25</td>
</tr>
<tr>
<td>2.3.3 Timing</td>
<td>26</td>
</tr>
<tr>
<td>2.4 Function of the Logic Matrix compared to the Safety Matrix</td>
<td>26</td>
</tr>
<tr>
<td>2.5 Implementation of the matrix in the automation system</td>
<td>27</td>
</tr>
<tr>
<td>2.5.1 Interconnection of the Logic Matrix with process tags (control modules)</td>
<td>28</td>
</tr>
<tr>
<td>2.5.1.1 Matrix links</td>
<td>29</td>
</tr>
<tr>
<td>2.5.1.2 Application of the matrix links</td>
<td>30</td>
</tr>
<tr>
<td>2.5.1.3 Advanced matrix links</td>
<td>32</td>
</tr>
<tr>
<td>3 Installing</td>
<td>37</td>
</tr>
<tr>
<td>3.1 Requirements for installation</td>
<td>37</td>
</tr>
<tr>
<td>3.2 Installing</td>
<td>37</td>
</tr>
<tr>
<td>3.3 Uninstalling the Logic Matrix components</td>
<td>39</td>
</tr>
<tr>
<td>4 Software user interface</td>
<td>41</td>
</tr>
<tr>
<td>4.1 Inserting a new Logic Matrix</td>
<td>41</td>
</tr>
<tr>
<td>4.2 Menu bar of the Logic Matrix</td>
<td>43</td>
</tr>
<tr>
<td>5 Configuring</td>
<td>45</td>
</tr>
<tr>
<td>5.1 Configuration guidelines</td>
<td>45</td>
</tr>
<tr>
<td>5.1.1 Basic procedure for creating a program</td>
<td>45</td>
</tr>
</tbody>
</table>

Logic Matrix
Configuration Manual, 01/2016, A5E35886614-AA
# Table of contents

5.1.2 Syntax rules for tag names in the Logic Matrix.................................................................46
5.2 Overview of Configuring........................................................................................................47
5.2.1 The tags of the Logic Matrix..........................................................................................47
5.2.2 Message configuration....................................................................................................48
5.2.2.1 Overview for configuring messages..........................................................................48
5.2.3 OS interface....................................................................................................................50
5.3 Editing the properties of the Logic Matrix...........................................................................50
5.3.1 "Properties" dialog box of the Logic Matrix.................................................................50
5.4 Configuring the causes........................................................................................................56
5.4.1 Overview for configuring the causes.............................................................................56
5.4.2 Creating/changing a cause and the rows for a cause......................................................56
5.4.3 Overview of the "Cause Details" dialog.........................................................................57
5.4.4 "Cause Details" dialog - "Configuration" tab...................................................................58
5.4.5 "Cause Details" dialog - "Analog parameters" tab...........................................................60
5.4.6 "Cause Details" dialog - "Digital parameters" tab.........................................................62
5.4.7 "Cause Details" dialog - "Authorization OS" tab.............................................................62
5.5 Configuring the effects........................................................................................................63
5.5.1 Overview for configuring the effects...............................................................................63
5.5.2 Creating/changing an effect and the column for an effect..............................................63
5.5.3 Overview of the "Effect Details" dialog box.................................................................64
5.5.4 "Effect Details" dialog - "Configuration" tab.................................................................64
5.5.5 "Effect Details" dialog - "Authorization OS" tab.............................................................65
5.6 Configuring the links...........................................................................................................66
5.6.1 Overview for creation of links........................................................................................66
5.6.2 Overview of the "LinkEditor" dialog box........................................................................71
5.6.3 Creating a new Cause link..............................................................................................75
5.6.4 Creating a new Effect link...............................................................................................75
5.7 Configuring the intersections..............................................................................................76
5.7.1 Editing or changing intersections..................................................................................76
5.7.2 "Intersection details" dialog box - "Configure" tab..........................................................76
5.8 Exporting/importing a Logic Matrix file.............................................................................78
5.8.1 Exporting a Logic Matrix file (.ods).............................................................................79
5.8.2 Editing an exported Logic Matrix file............................................................................79
5.8.3 Importing a Logic Matrix file (.ods).............................................................................100

6 Transfer Logic Matrix.............................................................................................................103
   6.1 Transferring the Logic Matrix to the project.....................................................................103
   6.2 Compiling and downloading to the CPU.........................................................................104
   6.3 Compiling and downloading to the Operator Station.......................................................105

7 Operator control and monitoring..........................................................................................107
   7.1 Overview of operator control and monitoring.................................................................107
   7.2 Expansion of the PCS 7 process tag browser.................................................................107
   7.3 Block icon and faceplates...............................................................................................108
   7.3.1 Structure of the user interface.....................................................................................108
   7.3.2 Views of the blocks....................................................................................................108
   7.3.3 Standard view of the matrix block.............................................................................110
7.3.4  Preview of the matrix block..............................................................................................117
7.3.5  Block icons for LM_Matrix..............................................................................................117
7.3.6  Standard view of the cause block....................................................................................120
7.3.7  Limit view of the cause block..........................................................................................123
7.3.8  Parameter view of the cause block................................................................................125
7.3.9  Preview of the cause block............................................................................................126
7.3.10 Standard view of the effect block ................................................................................127
7.3.11 Parameter view of the effect block................................................................................130
7.3.12 Preview of the effect block............................................................................................131

Index....................................................................................................................................................133
1.1 What is the Logic Matrix?

SIMATIC Logic Matrix is a tool for the creation and visualization of interlock operations with up to 125 causes and 125 effects.

A cause represents a logical function with up to six inputs (three analog and three digital). Its result is good or bad, and its effect can be passed on via nodes (intersections) to effects with one or multiple outputs. This allows each cause to act on any effect, or act only on a specific subset of the effects.

**Note**

**Limits for cause inputs and effect outputs**

Due to the system load from the visualization of the values, we recommend you create a total of no more than 250 cause inputs and 250 effect outputs for each matrix.

The outputs of Logic Matrix themselves have various functions, such as time delay or bypass. An output of the Logic Matrix with its functionality represents an ‘effect’.

**Note**

The SIMATIC Logic Matrix software is not a visualization of the contents in the CFC database. Rather, it is independent software that generates a CFC based on an interlocking logic created with this software and interconnects this CFC with existing CFCs.

**NOTICE**

**Multi-user engineering**

Multi-user engineering is not available within the Simatic Logic Matrix Editor. You cannot work on the project in the Simatic Manager during generation of a logic matrix. All editors that access data of the program should be closed.
1.2 Optional packages of the Logic Matrix

Optional packages and range of functions

Logic Matrix consists of two products, which can also be purchased separately.

Table 1-1 Range of functions of the Logic Matrix optional packages

<table>
<thead>
<tr>
<th>Optional package</th>
<th>Range of functions</th>
<th>Environment</th>
<th>Operating mode</th>
<th>Utilization phase</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC Logic Matrix</td>
<td>Creating, configuring a Logic Matrix,</td>
<td>Engineering System (ES)</td>
<td>Offline</td>
<td>Analysis and implementation</td>
</tr>
<tr>
<td>Editor (ES Package)</td>
<td>automatic generation of CFCs in a PCS 7 project on a PCS 7 engineering system (ES).</td>
<td>PCS 7 and CFC</td>
<td></td>
<td>phase</td>
</tr>
<tr>
<td>SIMATIC Logic Matrix</td>
<td>Operator control and monitoring using icons, faceplates, and ActiveX Controls on a PCS 7 Operator Station (OS)</td>
<td>PCS 7 Operator Station (OS)</td>
<td>Online</td>
<td>Operational phase (operator control and monitoring)</td>
</tr>
<tr>
<td>Viewer (OS Package)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1.3 Definition of terms

Main terms of the Logic Matrix are explained below.

Cause

A "cause" represents a process event.

The cause represents the trigger for activating an effect. Certain conditions must be fulfilled for the cause to become active and thus to trigger an effect defined by an intersection.

Three analog and three digital values are available for selection as input type at the cause. The values of at least one but no more than six input tags together with the function type represent a cause.

You can create a maximum of 125 causes.

Causes are arranged in rows in the Logic Matrix.

Effect

An "effect" represents the reaction that Logic Matrix exerts on the process.

Certain conditions must be fulfilled in order for the effect to become active and thus to trigger an action in the process by means of its output tags.

The activation of an effect depends on various factors (state of the assigned causes, type of intersection, specified options for the effect).

You can create a maximum of 125 effects. In principle, the number of output tags associated with an effect is not limited.

Effects are arranged in columns in the Logic Matrix.
Link

A link specifies the link information between the Logic Matrix and the user program.
A link defines the inputs and outputs of a cause which are connected to a process tag, or the
inputs of a process tag to which the effect output is connected.
Using this information, the Logic Matrix block from the compiler is interconnected to blocks in
the project.

Intersection

The Logic Matrix intersections specify the causes and types (not stored, stored, overridable,
not overridable) acting on the individual effects.
You can define up to 1024 intersections.

Active

A cause or effect can be active, which means that it has been tripped.
Whether or not a cause is active and when it becomes active is determined by the input tags,
the function type, and the options for the cause.
The activation of an effect depends on the relationship (defined by intersections) to the causes
and the options for the effect. If an effect is active, the output tags are set to "0" (= DTT
Deenergize-to-trip) or "1" (ETT = Energize-to-trip).

Inactive

A cause or effect can be inactive, which means that the conditions for activation are not fulfilled.
Whether or not the cause is inactive is determined by the input tags, the function type, and the
options for the cause.
The deactivation of an effect depends on the relationship (defined by intersections) to the
causes and the options for the effect. If an effect is inactive, the output tags are set to "1" (= DTT
Deenergize-to-trip) or "0" (ETT = Energize-to-trip).

Function type

The function type combines with the input tags and their options to govern whether and when
a cause is active or inactive.
- OR: One or more input tags must be active for the cause to become active.
- AND: All existing input tags must be active for the cause to become active.
- $X \circledast Y$: $X$ of $Y$ input tags must be active for the cause to become active.

Energize-to-trip (ETT)

Digital inputs and outputs: Inactive = 0, active = 1
Deenergize-to-trip (DTT)

Digital inputs and outputs: Inactive = 1, active = 0

Bypass

Bypass function that is normally used for maintenance purposes (e.g., for checking effect logic, replacing a sensor).

If a bypass is active, the cause/effect cannot become active even if the tripping condition and options are fulfilled.

1.4 Overview of procedure

This chapter provides a brief overview of the procedure to be followed when using Logic Matrix components within the PCS 7 automation system.

<table>
<thead>
<tr>
<th>Step</th>
<th>Required user steps</th>
<th>Component</th>
<th>See Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Inserting a new Logic Matrix</td>
<td>Simatic Manager</td>
<td>Inserting a new Logic Matrix (Page 41)</td>
</tr>
<tr>
<td>2</td>
<td>Editing the properties of the Logic Matrix</td>
<td>Logic Matrix Editor</td>
<td>&quot;Properties&quot; dialog box of the Logic Matrix (Page 50)</td>
</tr>
</tbody>
</table>
| 3    | Configuring the functions of the Logic Matrix: Causes, Effects, Links, Intersections | Logic Matrix Editor | Configuring (Page 45)  
  ● Configuring the causes (Page 56)  
  ● Configuring the effects (Page 63)  
  ● Configuring the links (Page 66)  
  ● Configuring the intersections (Page 76)  |
| 4    | Transfer Logic Matrix       | Logic Matrix Editor | Transfer Logic Matrix (Page 103)               |
| 5    | Transferring and loading    | Simatic Manager   | Compiling and downloading to the CPU (Page 104) |
| 6    | Operator control and monitoring | WinCC Runtime  | Operator control and monitoring (Page 107)     |
Function of the Logic Matrix

2.1 Matrix

The matrix interconnects causes and effects via "nodes".

The cause evaluates its input signals with the 'good' or 'bad' result. The result is linked with an effect via a node. There are different types of nodes as well, which influence the effect in various ways (see details Effect (Page 23)).

If a cause is considered to be 'bad', the effects linked via nodes are triggered in the manner defined by the node. A simple matrix might look like this:

```
+-----------+-----------+-----------+
<table>
<thead>
<tr>
<th></th>
<th>Effect001</th>
<th>Effect002</th>
<th>Effect003</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause001</td>
<td>N</td>
<td>S</td>
<td>V</td>
</tr>
<tr>
<td>Cause002</td>
<td>R</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Cause003</td>
<td>N</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Image 2-1 Simple matrix

For example, if Cause003 is 'bad', Effect001 is triggered as not stored, not overridable. The single nodes of different causes that act on the same effect are always 'ORed'. This means the effect can be triggered by each of the nodes. If multiple nodes of different types act on the effect, the 'strongest' effect is always triggered as a result (for details, see section Effect (Page 23)).

In addition to single nodes, there are 'multi-nodes'. These are distinguished by the fact that they combine the results of several causes in a logical function to trigger the effect. A 'multi-node' might look like this:

```
+-----------+-----------+-----------+
<table>
<thead>
<tr>
<th></th>
<th>Effect001</th>
<th>Effect002</th>
<th>Effect003</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause001</td>
<td>2N</td>
<td>S</td>
<td>V</td>
</tr>
<tr>
<td>Cause002</td>
<td>2N</td>
<td>R</td>
<td>N</td>
</tr>
<tr>
<td>Cause003</td>
<td>2N</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Image 2-2 Simple matrix with 'multi-nodes'

A multi-node is always displayed with a number and the type of node. In this case, it is a non-stored, non-overridable node (N). The number 2 means that the 'multi-node' triggers the effect if at least 2 of the causes linked via the multi-node are 'bad'. Since 3 causes are linked via the multi-node, the logic function is 2oo3 (2 out of 3).
There can be only one multi-node per effect. Single nodes can exist at the same time. These are then 'ORed' with the multi-node.

A special feature of the multi-node is the reaction when causes are bypassed. If causes acting on the multi-node are bypassed, the function of the multi-node is reduced (the multi-node reacts like the cause logic function, see section Degraded voting (Page 21)).

Note

*Important: The logic function of the multi-node always describes the 'bad' case. In other words, 2 means that the effect is triggered because two causes are 'bad'.*

### 2.2 Cause

The cause evaluates its analog and digital input signals for various configurable criteria.

Analog inputs can be evaluated according to the following criteria:
- High or low limit violations
- Gradient exceeded in positive or negative direction
- Deviation limit exceeded (for multiple analog inputs)
- Signal status

Digital inputs can be evaluated using the following criteria:
- Value
- Signal status

Each input is evaluated and the result is 'good', 'bad' or 'excluded from voting'. The results of this evaluation, in turn, are evaluated using a configurable logic function and passed to the matrix. The possible logic functions depend on the number of cause inputs used.

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Possible functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>OR</td>
</tr>
<tr>
<td>2</td>
<td>OR, AND</td>
</tr>
<tr>
<td>3</td>
<td>OR, 2oo3, AND</td>
</tr>
<tr>
<td>4</td>
<td>OR, 2oo4, 3oo4, AND</td>
</tr>
<tr>
<td>5</td>
<td>OR, 2oo5, 3oo5, 4oo5, AND</td>
</tr>
<tr>
<td>6</td>
<td>OR, 2oo6, 3oo6, 4oo6, 5oo6, AND</td>
</tr>
</tbody>
</table>

Possible cause logic functions
Note

Important: The cause logic function always describes the 'bad' case. In other words:
- **2oo3** means that the cause is 'bad' when two inputs have been evaluated as 'bad'.
- **AND** means that the cause is 'bad' if all inputs have been evaluated as 'bad'.
- **OR** means that the cause is 'bad', if at least one input has been evaluated as 'bad'.

The graphic below shows the signal processing within a cause.

![Image 2-3 Signal processing in the cause](image)

In the first step, the input signal is evaluated based on value, signal status and configured options. The result of the evaluation is 'good', 'bad', 'discarded' or 'bypassed'.

In the second step, it is determined whether the cause is 'good' or 'bad' based on the input evaluation and the cause logic function.

In the last step, a time delay is optionally implemented or the cause as a whole is bypassed.
2.2.1 Analog input voting

Analog input voting

An analog input is evaluated according to various criteria.

1. Limits:
   A warning and an alarm limit are available for each analog input. Depending on the setting,
   this may involve a high or low limit.
   If the warning limit is violated, a warning is generated. The warning limit is not incorporated
   into the cause logic function.
   If the alarm limit is violated, a warning is generated stating that an input of the cause is
   'bad'. The value is entered in the cause logic function as 'bad'.

2. Gradient:
   The gradient can be monitored in positive and negative directions for each analog input. If
   the limit for the gradient is violated, a warning message is generated. When the 'Trip on
   Gradient' feature is enabled, the value is entered in the cause logic function as 'bad'.
   Inputs with measurement noise can be filtered through a P-T1 filter.

3. Signal status:
   Depending on the settings of the signal status handling, an input with a bad signal status
   is entered in the cause logic function as 'bad' or it is excluded from the voting (see section
   Signal status (Page 20) and section Degraded voting (Page 21)).

   In addition, an analog input can be evaluated for its deviation from the other analog inputs.
   You can find a description of this in section Analog input deviation (Page 18)

2.2.2 Analog input deviation

Analog input deviation

The evaluation of the analog inputs based on their deviation from each other differs from the
other evaluation criteria, because it does not depend solely on the evaluated input. The
evaluation depends on whether two or three analog inputs are considered and whether the
signal status is taken into consideration.

2 analog inputs:

With two analog inputs, both analog inputs are evaluated as 'bad' when they differ by more
than what is specified. This means they can enter into the cause logic function as two 'bad'
inputs (depending on the settings for 'Trip on Deviation' and 'Quality Code voting').

3 analog inputs:

With three analog inputs, the input with the mean value is assumed to be correct. The two
remaining values are evaluated based on their deviation from each other and their deviation
from the mean.
A value that deviates by more than the predetermined limit from the mean is always 'bad'.
If the high and the low value deviate from each other by less than the specified limit from the mean but by more than the specified limit from each other, the value considered 'bad' is the one with the greater deviation from the mean.

Signal status:
In addition to the number of analog inputs, the signal status also has an effect on the evaluation, depending on the enabled options: If the signal status evaluation is enabled, a value with a bad signal status for the deviation is excluded from consideration. A value with a good signal status is not evaluated as 'bad' due to a value with a bad signal status. In other words, no deviation evaluation takes place with only two analog inputs. The remaining value is 'good' from the perspective of the deviation. With three analog inputs, only the two remaining inputs are evaluated with respect to the deviation.

Trip on deviation:
If the 'Trip on Deviation' function is disabled (default), a deviation only leads to a warning message. However, the affected value(s) are not entered as 'bad' values in the cause logic function.

2.2.3 Digital input evaluation

Digital input evaluation

A digital input can be monitored for its value and signal status.

1. Value monitoring
   A setting can be made individually for each digital input to specify whether a high signal (ETT) or low signal (DTT) is to be evaluated as 'bad'. Flutter suppression can be enabled for unstable input signals. This is an ON and OFF delay of the signal. There is no monitoring of the number of non-effective signal changes.

2. Signal status:
   Depending on the settings of the signal status handling, an input value with a bad signal status is entered in the cause logic function as 'bad' or it is excluded from the voting (see section Signal status (Page 20) and section Degraded voting (Page 21)).
2.2.4 Signal status

Signal status

The evaluation of the signal status depends on the features.

- A: ‘Enable Quality Code voting'
- B 'Enable degraded voting'

If both features are disabled, the signal status is ignored.
If Feature A is enabled, an input with a bad signal status is entered in the cause logic function as 'bad'.
If Feature A and Feature B are enabled, an input with bad signal status is excluded from the voting and not included in the cause logic function (see section Degraded voting (Page 21)).

2.2.5 Bypass

Bypass

There are several ways to set bypasses at a cause:

- The cause can be bypassed as a whole.
- Each input or the effect of each input signal at the cause can be bypassed.

If the cause is bypassed as a whole, it has no influence on the effects linked by single nodes.
If the bypassed cause is connected through multi-nodes, it is excluded from the voting for the affected multi-nodes (see section Degraded voting (Page 21)).

A bypassed cause does not generate any additional messages except for the bypass message.

If the effect of a cause input is bypassed, the corresponding input for the cause logic function is excluded from the voting (see section Degraded voting (Page 21)).

A bypassed cause input does not result in another message of the cause apart from a bypass message.
2.2.6 Timing

Timing

A time response can be configured for the impact of a cause on the nodes of the matrix and thus on the effects. The graphic below shows the configurable time response.

![Image 2-4 Cause timing](image)

The color-coded bars in the “Timing response of cause” figure show the output of the cause which is passed on to the matrix. 'Without time response' corresponds to the output of the cause logic function before the time level.

2.2.7 Degraded voting

Degraded voting

Input signals of a cause can be excluded from the voting due a bad signal status or a bypass, or be evaluated as 'bad'. Whether a bad signal status is ignored, evaluated as 'bad' or results in excluding an input from the voting, depends on several factors.

The table below shows the result of a voting of an input as a function of the process value, signal status and bypass:
### Image 2-5 Table: Evaluation of an input signal

<table>
<thead>
<tr>
<th>Process value</th>
<th>Input Signal status</th>
<th>Bypassed (Bypass)</th>
<th>A: Active B Inactive</th>
<th>A: Active B Active</th>
<th>A: Inactive B Inactive</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poor</td>
<td>Good</td>
<td>No</td>
<td>Poor</td>
<td>Poor</td>
<td>Poor</td>
</tr>
<tr>
<td>Good</td>
<td>Good</td>
<td>No</td>
<td>Good</td>
<td>Good</td>
<td>Good</td>
</tr>
<tr>
<td>Poor</td>
<td>Poor</td>
<td>No</td>
<td>Poor</td>
<td>Discarded</td>
<td>Poor</td>
</tr>
<tr>
<td>Good</td>
<td>Poor</td>
<td>No</td>
<td>Poor</td>
<td>Discarded</td>
<td>Good</td>
</tr>
<tr>
<td>Poor</td>
<td>Good</td>
<td>Yes</td>
<td>Bypassed</td>
<td>Bypassed</td>
<td>Bypassed</td>
</tr>
<tr>
<td>Good</td>
<td>Good</td>
<td>Yes</td>
<td>Bypassed</td>
<td>Bypassed</td>
<td>Bypassed</td>
</tr>
<tr>
<td>Poor</td>
<td>Poor</td>
<td>Yes</td>
<td>Bypassed</td>
<td>Bypassed</td>
<td>Bypassed</td>
</tr>
<tr>
<td>Good</td>
<td>Poor</td>
<td>Yes</td>
<td>Bypassed</td>
<td>Bypassed</td>
<td>Bypassed</td>
</tr>
</tbody>
</table>

A: 'Enable Quality Code voting’  
B: 'Enable degraded voting’  
Bypassed: Bypass  
Discarded: Discarded due to poor signal status

An input is 'good', 'bad', 'discarded' or 'bypassed' in the result.
This result flows into the cause logic function. Discarded or bypassed signals result in a change to the cause logic function. For example, a 2oo3 (2 out of 3) logic would be reduced to a 2oo2 logic. Another discarded signal would lead to a 1oo1 logic. Discarded or bypassed signals have the same effect here – except when all the input signals have been bypassed.

The table below shows the result of the cause logic function using the example of a 2oo3 function based on differently evaluated input signals (see "Table: Evaluation of an input signal").
Degraded voting for multi-nodes

Multi-nodes react just like the cause logic function in their logical function. As inputs of the multi-node, however, the causes can only have the states 'good', 'bad' or 'bypassed'. This means that, if all causes of a multi-node have been discarded, the result is 'good' (see "Table: Result of the cause logic function with 2oo3", rows 1 to 7, as an example).

### Effect

The effect is controlled from the matrix via nodes (type N, S, V, R). The effect does not distinguish between normal nodes and multi-nodes, but only according to the node types. If a signal is 'bad', the effect becomes 'bad'. There is different response depending on the type of node through which the effect is enabled.

#### Node type | Effect
--- | ---
N | Non-stored, not overridable
S | Stored, not overridable
Node type  

<table>
<thead>
<tr>
<th>Node type</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>V</td>
<td>Non-stored, not overridable</td>
</tr>
<tr>
<td>R</td>
<td>Stored, overridable</td>
</tr>
</tbody>
</table>

Node types:  

1: Overriding is a temporary bypass, which requires a lower operating authorization than an open-ended bypass.

If multiple nodes of different types act on the effect, the strongest effect is always triggered as a result:

- If an overridable and non-overridable node act on the effect, the effect cannot be overriden in the result.
- If a stored and non-stored node act on the effect, the effect is triggered stored.
- If a non-stored, non-overridable (N) and a stored, overridable (R) node act on the effect, the effect remains non-overridable as long as the non-stored, non-overridable node (N) acts. Once this is 'good' again, the effect is latched as triggered and overridable (R).

Before the result of this logic is passed on to the effect output, it can be assigned a time response, be bypassed and optionally overridden.

The figure below shows the signal processing of the effect:

Bypass  

The bypass of an effect sets the output of the effect to 'good'. A bypass message is enabled. The bypass of the effect stops the overriding of the effect. The bypass is made directly in front of the output. In other words, any time response has no effect on the bypass.

The effect may be bypassed at any time.
2.3.2 Override

Override

It is only possible to override an effect if the effect was triggered as overridable and no bypass has been set.

As in a bypass, an override acts directly in front of the effect output. Any time response of the output has no effect on the override. The effect can be overridden directly after the occurrence of an overridable activation, even if the signal has not yet arrived at the effect output due to possible time delays.

A bypass message is generated as long as the effect is overridden.

Override time response

The overriding of the effect can be limited by configuring a time.

If a time is configured for an override, a pre-warning time can be configured as well. The pre-warning time indicates the time at which a corresponding warning is generated before the end of an override.

Stopping override

The override of the effect is stopped by the following events, without it being stopped by an operator action:

- Setting the bypass of the effect
- Expiration of the configured maximum override time
- Triggering the effect by another node (edge) even if it is overridable
2.3.3 Timing

Timing

A time response can be set for the output of an effect. The graphic below shows the configurable time response.

The color-coded bars in the figure show the output of the effect. 'Without time response' corresponds to the result of the effect logic.

2.4 Function of the Logic Matrix compared to the Safety Matrix

The SIMATIC Logic Matrix is based in its function on the Safety Matrix but has a different focus when it comes to automation.

Safety systems are relatively independent from the rest of automation in their function and therefore often have their own I/O signals. Accordingly, the Safety Matrix generates its own I/Os under normal circumstances. Signals to and from the process tags are also available, but they are exceptions and must be interconnected manually by the user, if necessary. This means the Safety Matrix is on the process tag level (control module level) as far as automation is concerned.
The Logic Matrix, on the other hand, does not have its own I/Os. Input and output signals of existing process tags and actuators are used instead. From an automation point of view, it is located above the process tag level (equipment module level).

To reduce the amount of work and avoid interconnection errors by the user, interconnections are made with interconnection definitions (so-called links) and not manually.

2.5 Implementation of the matrix in the automation system

A matrix always consists of a number of causes, a connecting matrix and a number of effects. We also encounter this configuration when the matrix is implemented as CFC in automation. The matrix CFC consists of a number of cause blocks (one for each cause), a matrix block and a number of effect blocks (one for each effect).

The graphic below shows the correlation between the matrix and the implementation of the matrix in automation.
The matrix block implements the links between cause and effect blocks according to the configured nodes.

The cause blocks implement the processing of the input signals according to the configured parameters (for details, see section Cause (Page 16)).

The effect blocks implement the post-processing of the nodes from the matrix, such as bypass, time delay, storage (for details, see section Effect (Page 23)).

2.5.1 Interconnection of the Logic Matrix with process tags (control modules)

Because the Logic Matrix itself does not have any I/Os, the CFC created from the matrix must be interconnected with the process tags in the project.

It is theoretically possible to generate the matrix CFC and to make the interconnections manually. However, it requires a lot of effort and the likelihood of errors is relatively high. The exact signal must be interconnected to the specific I/O in the matrix CFC for visualization (e.g. comments and process tag names) and the actual function to match. Therefore, the interconnection of the matrix with the process tags is defined within the matrix.
2.5.1.1 Matrix links

Matrix links

The interconnection of the matrix with a process tag requires in-depth knowledge of the matrix CFC and its blocks as well as the process tag CFC to be connected and its blocks. From the several hundred signals of a process tag CFC, only a few are of importance for the matrix. For a valve process tag, for example, only 'Valve open' and 'Valve closed' may be of importance for the matrix as an input. It depends on the process tag type which signals are of importance. Only a 'Motor running' signal can be relevant for a motor process tag.

This is why there are so-called links for effective configuration of the matrix. Links are interconnection definitions. In the simplest case, one single interconnection is defined for exactly one process tag type in a link.

We distinguish between digital, analog and effect links in the matrix. The digital links are used to define the interconnection with the digital cause inputs. Accordingly, the analog links are used to define the interconnection of analog cause inputs and the effect links to define the interconnection of the effect outputs.

As with the interconnection in the CFC, the creation of links, too, requires in-depth knowledge of the matrix and process tag types. However, the creation of a basic link is not any more complicated than an interconnection in the CFC.

A basic link only requires the following information:

- Link type (analog, digital, effect)
- Process tag type to which the link can be applied
- Block and I/O to which the link is connected

---

**NOTICE**

**Block names**

Because a link always refers to a specific block within a process tag type, the block names within the instances may not be changed.
2.5.1.2 Application of the matrix links

Application of the matrix links

To interconnect the input of a cause or the output of an effect, you only have to select the process tag and the link in the matrix. The actual interconnection is created during generation of the matrix. This process has some advantages:

- Once the links have been defined, the matrix can be created by a user without in-depth knowledge using the matrix and the process tag CFCs. To interconnect a cause input with a valve process tag, for example, only the process tag 'Valve123' and the link 'Valve open' must be selected.

- Due to the limited selection of possible interconnections compared to a CFC interconnection, an interconnection of the matrix can be configured faster and with less likelihood of an error (there are typically hundreds of I/Os in a process tag CFC that can be interconnected while a structured project only includes up to four or five links for a process tag type).

- Any changes made at a later time can be transferred to all interconnections of the matrix by changing the link definition and subsequent generation.

- The matrix is independent of the implementation in the CFC and can therefore be reused in later projects, for example. Only the link definitions have to be changed.

- Link definitions can be reused in later projects if the same process tag types are used there.

Example of a basic link:

We are using a closed valve as input condition for the matrix in this example.

The connection looks as follows in the Matrix Editor:
You can see that experience with PCS7 or the process tag is not required to configure this interconnection in the Matrix Editor. If the links are named according to their function (in the example, 'Closed', for the position feedback 'Closed' of a valve process tag), you only have to select the process tag and the corresponding function. The editor only offers users links that are suitable for the process tag type.

The link definition includes the following information for the link (the link definition is created by a user with expert knowledge of process tag types.):

<table>
<thead>
<tr>
<th>Link name</th>
<th>Link type</th>
<th>Scope (can be applied to ...)</th>
<th>Interconnections</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>Digital</td>
<td>Valve process tag</td>
<td>V.FbkCloseOut &lt;-&gt; Cause.Dig *</td>
</tr>
</tbody>
</table>

* Representation of the CFC I/O: Block_name.Connector_name. The process tag name for the corresponding I/O is specified by the user in the Matrix Editor.

Representation connection to the matrix: 'Cause.Dig' is to be understood as a symbol. It means digital input at the cause. The link definition does not specify the digital input to which it is referring and the cause at which it has to be located (the cause block has up to three digital inputs). This information is the result of the arrangement of the matrix. This means in the example (see figure 'Interconnection in the Matrix Editor'), this would be Cause 0 (cause number in the table) and the I/O Dig1 (the first of the digital inputs).

Based on the information in the Matrix Editor and in the link definition, the matrix CFC generator creates the interconnection displayed in the figure below:
2.5 Implementation of the matrix in the automation system

2.5.1.3 Advanced matrix links

Extended matrix links

As mentioned above, a matrix link consists of at least one connection. But there are also applications in which a matrix link consists of multiple or alternative interconnections.

Multiple interconnections using an analog link as example

In an analog link, at least the process value is interconnected with the process tag. However, it is not unusual for more signals to be interconnected. In addition to the process value, the technological unit and the measuring range of the process tag are usually interconnected. When using limits, the limit of the process tag may be applied as the limit for the analog input of the matrix (cause), or the limit of the matrix (cause) is to be applied by the connected process tag as a limit.

Example:

An analog link is to be created. The process value, limit and technological unit are to be interconnected. The limit of the matrix (cause) is to be applied by the process tag. The link definition basically looks as follows:

<table>
<thead>
<tr>
<th>Link name</th>
<th>Link type</th>
<th>Scope (can be applied to …)</th>
<th>Interconnections</th>
</tr>
</thead>
</table>

Definition of an analog link

Image 2-13  Interconnection of a digital input in the matrix

Manual interconnections are complex and prone to errors.
In the Matrix Editor, the interconnection of the analog process tag with the analog input of the matrix (cause) is not more complicated than an interconnection with a basic link.

![Image 2-14 Interconnection of an analog value in the Matrix Editor](image)

Based on the information in the Matrix Editor and in the link definition, the matrix CFC generator creates the interconnections displayed in the figure below:
Alternative interconnections using an effect link as example

Alternative interconnections can be used when there are block inputs with the exact same function at a target process tag. The typical application is interconnection to an interlock block. An interlock block has up to 16 inputs with the exact same functionality. It is used to implement interlocks through signals of the own process tag or from other process tags.

From an automation point of view, the Logic Matrix is considered to be a higher-level interlock. This means one possible plant concept would be to implement local interlocks, such as underfill protection or a motor starter protector, at the process tag using interlock blocks, while interlocks that affect an apparatus across multiple process tags are implemented with the Logic Matrix. To do so, it would make sense to connect outputs of the Logic Matrix (effect) to interlocks of the corresponding process tags.

The Logic Matrix is generated when the process tags already exist. This means it may be possible that some interlock inputs are already used by local interlock signals. The local interlocks are not process tag specific but they are instance-specific, which means they are different for each process tag. To connect such process tags to the Logic Matrix, you make use of so-called alternative interconnections:

In this case, the generator tries to establish the interconnection to the first I/O. If it is already in use, the generator tries to connect to the next I/O and so forth.
Example: A motor process tag with Interlock8 (8 inputs) is to be connected to the matrix (effect) by means of an alternative effect link. The link definition basically looks as follows:

<table>
<thead>
<tr>
<th>Link name</th>
<th>Link type</th>
<th>Scope (can be applied to ...)</th>
<th>Interconnections</th>
</tr>
</thead>
</table>

Definition of an alternative link

A link with alternative interconnections is created in the exact same way as an analog or digital link in the Matrix Editor.

Image 2-16 Interconnection of an effect in the Matrix Editor

**Scope ("can be applied to") of a link definition**

All link definitions shown before have always referred to exactly one process tag type. However, as the last example of the connection of the matrix outputs (effect) to interlock blocks shows, it may be possible and useful for link definitions to be applied to different process tag types.
There is most likely more than one motor process tag type in the project, but all motor process tag types have an interlock block called 'Intlock' that is to be connected. It may even be possible that the valve process tag types also have interlock blocks called 'Interlock' and that the link definition is also going to be applied to these process tag types. The link definition can be extended to include multiple scopes in this case:

<table>
<thead>
<tr>
<th>Link name</th>
<th>Link type</th>
<th>Scope (can be applied to ...)</th>
<th>Interconnections</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interlock</td>
<td>Effect</td>
<td>Motor process tag type 1</td>
<td>Effect.Out ↔ Intlock.In01</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Motor process tag type 2</td>
<td>or Effect.Out ↔ Intlock.In02</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Motor process tag type 3</td>
<td>or Effect.Out ↔ Intlock.In03</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Valve process tag type 1</td>
<td>or Effect.Out ↔ Intlock.In04</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Valve process tag type 2</td>
<td>or Effect.Out ↔ Intlock.In05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Valve process tag type 3</td>
<td>or Effect.Out ↔ Intlock.In06</td>
</tr>
</tbody>
</table>

Definition of an alternative link with extended scope
3.1 Requirements for installation

Hardware components
For information on the hardware components of PCS 7, refer to the “PCS 7 Process Control System, Configuring and Programming” programming and operating manual. Additional information on this document is available in the preface.

Software requirements
The following software is required to operate the complete range of functions of the Logic Matrix components.

Logic Matrix Engineering Tool
To operate the Logic Matrix Engineering Tool, you must have installed the following software packages on the ES:
- PCS 7 as of V8.2
- Windows version corresponding to PCS 7 version
- Automation License Manager (ALM) corresponding to PCS 7 version

Logic Matrix Viewer
To operate the Logic Matrix Viewer, you must have installed the following software packages on the OS:
- PCS 7 Operator Station as of V8.2
- Windows version corresponding to PCS 7 version
- Automation License Manager (ALM) corresponding to PCS 7 version

3.2 Installing

Note
For installation of the Logic Matrix Engineering Tool/Viewer, the same requirements apply as described in the PCS 7 operating manual "PC Configuration and Authorization". Additional information on this document is available in the preface.
Reading Readme files

Important current information about the supplied software can be found in the "Logic Matrix Engineering – Readme" files. You can have these files displayed at the end of the setup program. You can open the readme file later by selecting SIMATIC > Product Information > English in the Windows Start menu. You will find the Readme files in the installation directory of the Logic Matrix.

Installing the Logic Matrix Editor

1. Start your ES. Ensure that no STEP 7 applications are open.
2. Insert the Logic Matrix product CD.
3. Start the SETUP.EXE program on the CD.
4. Follow the instructions of the setup program.
   Select the component Logic Matrix Engineering in the setup.

Installing the Logic Matrix Viewer

1. Start your ES/OS. Ensure that no SIMATIC applications are open.
2. Insert the Logic Matrix product CD.
3. Start the SETUP.EXE program on the CD.
4. Follow the instructions of the setup program.
   Select the Logic Matrix Viewer component in the setup.

Web capability of the Logic Matrix

Note

To display the Logic Matrix on a Web client, the "Microsoft.Net 4.5" software must be installed on the Web client.

The software is available on the PCS 7 Toolset DVD.

License key (usage authorization)

A license key is required for each component of Logic Matrix. This license key is installed in the same way as for STEP 7 and the optional packages. For information on installing and working with license keys, refer to the Readme file and the STEP 7 basic help.

Documentation

When a component of Logic Matrix is installed, a shortcut for German and English with the name 'Logic Matrix - Engineering Tool' is stored in the respective SIMATIC directory for manuals (Windows Start menu in the subdirectory SIMATIC > Documentation).
3.3 Uninstalling the Logic Matrix components

Uninstalling the Logic Matrix components

Note

For uninstalling the Logic Matrix Engineering Tool/Viewer, the same requirements apply as described in the "PCS 7 Process Control System; PC Configuration and Authorization" Manual. Additional information on this document is available in the preface.

Use the normal procedure in Windows for uninstalling software:

1. In Windows, double-click the "Add or Remove Programs" icon in "Control Panel" to open the dialog box for installing software.

2. Select the "SIMATIC PCS 7 Logic Matrix Engineering Tool", "SIMATIC PCS 7 Logic Matrix Faceplates" and/or "SIMATIC PCS 7 Logic Matrix Library" entry in the list of installed software. Click the "Add/Remove" button to uninstall the software.
3.3 Uninstalling the Logic Matrix components
4.1 Inserting a new Logic Matrix

Matrix object
In a SIMATIC project, the cause/effect logic is stored in a Logic Matrix object in which the logic is set and transferred to a CFC in the form of function blocks. Each Logic Matrix object supports up to 125 causes and 125 effects with a maximum of 1024 intersections. Depending on its memory capacity, one CPU can support several matrices.

Adding a Logic Matrix object in a project
1. Open SIMATIC Manager and select the component view.
2. Open the project in SIMATIC Manager.
3. Navigate to the S7 program folder in the project.
4. Right-click the S7 program folder, and select Insert New Object > Logic Matrices Folder. A new Logic Matrix folder named “Logic Matrices” is created in the S7 program.
5. Right-click the matrix folder, and select Insert new object > Matrix.
6. Enter a name (up to 24 characters) for the Logic Matrix object. Make sure that the assigned name is unique from all others in the system. This entry is not case-sensitive.
7. Double-click the Logic Matrix object in SIMATIC Manager.

Note
The name of the CFC generated from the Logic Matrix Editor is derived from the name of the matrix. Therefore, the names of matrix objects are subject to the same restrictions as the names of CFCs.
Software user interface

4.1 Inserting a new Logic Matrix

Result

The Logic Matrix Engineering Tool opens the Logic Matrix. The following figure shows the user interface of a Logic Matrix.

See also

Importing a Logic Matrix file (.ods) (Page 100)
### 4.2 Menu bar of the Logic Matrix

#### Overview of menu bar

The menu bar of the Logic Matrix contains the following menu commands:

- File
- Edit
- View
- Generation
- Window
- Help

The respective subcommands of the menu commands are explained below.

#### The "File" menu command

You edit a Logic Matrix file with the commands of this menu command.

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open...</td>
<td>Shows the Open dialog for selecting and opening a previously configured Logic Matrix. You use this option to open a Logic Matrix for editing.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the current Logic Matrix in a file. All changes of the Logic Matrix are saved, which means the new Logic Matrix replaces the older version. When a Logic Matrix is overwritten in a project, you are prompted to check the log file and specify which changes you want to accept (critical/non-critical). Likewise, you will be prompted to enter the password for the safety program. A password is not required if you save the Safety Matrix as a new file.</td>
</tr>
<tr>
<td>Export...</td>
<td>Exports the content of the active Logic Matrix as an *.ods file for further processing outside the editor</td>
</tr>
<tr>
<td>Import...</td>
<td>Import function for reading the externally processed matrix</td>
</tr>
<tr>
<td>Recent Files</td>
<td>Shows the most recently opened matrices on this station and allows these matrices to be opened.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes all dialog boxes and exits the program. The Exit command is only available in offline mode.</td>
</tr>
</tbody>
</table>

#### The "Edit" menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties...</td>
<td>The &quot;Properties&quot; dialog offers comprehensive information and input options regarding the general Logic Matrix properties. See section &quot;Editing the properties of the Logic Matrix (Page 50)&quot;.</td>
</tr>
<tr>
<td>Links...</td>
<td>The &quot;Links&quot; command opens the Link Editor. See section &quot;The Link Editor of the Logic Matrix (Page 71)&quot;.</td>
</tr>
<tr>
<td>Read project data</td>
<td>The &quot;Read project data&quot; command reads the latest information from the project where the Logic Matrix is.</td>
</tr>
</tbody>
</table>
### The "View" menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend</td>
<td>The &quot;Legend&quot; function shows the legend of the intersection configuration.</td>
</tr>
</tbody>
</table>

### The "Generation" menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate Matrix</td>
<td>The charts of the Logic Matrix are generated in the project with the &quot;Generate Matrix&quot; function. See section &quot;Transfer Logic Matrix (Page 103)&quot;.</td>
</tr>
<tr>
<td>Read back parameters</td>
<td>The &quot;Read back parameters&quot; function is used to read the parameters of the Logic Matrix that can be operator controlled and monitored from the CFC back into the editor.</td>
</tr>
<tr>
<td>View generating log</td>
<td>The &quot;View generating log&quot; command displays the log of the most recent generation process.</td>
</tr>
</tbody>
</table>

### The "Window" menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrangement</td>
<td>The &quot;Arrangement&quot; function can be used to display multiple logic matrices as cascaded [Cascade], horizontal [Tile Horizontal] and vertical [Tile Vertical].</td>
</tr>
<tr>
<td>Open matrices</td>
<td>Shows the currently opened matrices and permits switching the currently displayed matrix.</td>
</tr>
</tbody>
</table>

### The "Help" menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>The &quot;Help&quot; function opens the Logic Matrix documentation.</td>
</tr>
</tbody>
</table>
5.1 Configuration guidelines

5.1.1 Basic procedure for creating a program

Introduction

Based on the popular cause/effect method, Logic Matrix offers an easy configuration in which you assign exactly defined reactions (effects) to occurring events (causes) and thus specify the system behavior of the system. Logic Matrix offers comprehensive support for this task through:

- Structured user interface
- Simple parameter assignment and linking of causes and effects
- Automatic checking of the configuration for validity
- Automatic generation of system program logic based on CFC with blocks from the Logic Matrix library
- Revision and change tracking, functions for comparing matrices and for support during system acceptance testing

Requirements

- You must have created a project structure in SIMATIC Manager.
- For engineering, we recommend using a type instance concept with master data library. The Logic Matrix works with the CFC types (process tag types and control module types) of the master data library.

Basic procedure

To create a program, follow these steps:

1. After you have specified the program structure, insert a Logic Matrix into the project.
2. Insert the following into the Safety Matrix
   - Input tags for causes
   - Output tags for effects in the Logic Matrix
3. Assign parameters for the following
   - Link types
   - Causes
   - Effects
   - Intersections

4. Run a CFC generation to transfer the function of Logic Matrix to a CFC.

5. Compile and download the S7 program and the OS.

6. Test and document the program.

7. Start commissioning and complete it.

5.1.2 Syntax rules for tag names in the Logic Matrix

**Permissible characters**

The tag names correspond to the process tag names from PCS 7. This means the naming conventions are based on the link names. Because they are displayed in WinCC, the rules for WinCC apply here.

The permitted character set is the range of ASCII characters from 16#20 (blank space) to 16#7a (lower case "z").

The pipe character (|) is not permitted.

---

**Note**

Ignored characters are discarded at the time they are entered without an error message. Immediately upon entry, you must verify that the tag name was entered correctly. Otherwise, compilation errors (symbol not defined) or collisions with existing symbols may occur.

Both upper case and lower case letters may be entered, but the symbols are not case-sensitive, i.e., symbols "TIC2344", "TiC2344" and "tic2344" are identical. Internal references are an exception (see below).

---

**See also**

Transfer Logic Matrix (Page 103)
5.2 Overview of Configuring

5.2.1 The tags of the Logic Matrix

Creating a cause

To add a new cause to a matrix, select the "Add Cause" function in the Causes area with the shortcut menu.

Adding inputs to causes

To assign a new input to a cause, open the shortcut menu of the cause and select the function "Add Cause Input".

To assign an input interconnection to the created input tag, open the shortcut menu of the input tag and select "Select Input Tag..." or "Direct connection...".

In the "Input Tag Selection" window, you can assign the input interconnection of an existing link to the input tag or create new links with the Link Editor.

In the "Select direct link" window, you can assign the input tag an interconnection to a connector of an existing block in the project.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can assign up to 6 input tags to a cause. You can assign a maximum of 3 analog and 3 digital links.</td>
</tr>
</tbody>
</table>

Limits for cause inputs and effect outputs

Due to the system load from the visualization of the values, we recommend you create a total of no more than 250 cause inputs for each matrix.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing the input type</td>
</tr>
<tr>
<td>If the input type of a cause input is changed from analog to digital by selecting an input tag again, the previous configuration of the parameters is lost. If the input tag is merely changed to another tag of the same type, the configuration is retained.</td>
</tr>
</tbody>
</table>

Creating a link

To create a new link, open the Link Editor with the menu command "Edit -> Links...".
Creating an effect

To add a new effect to a matrix, select the "Add Effect" function in the Effects area with the shortcut menu.

Note

There is no limit to the number of output tags that you can assign an effect. However, you should note that the output tags are displayed in the faceplate and this can lead to a confusing display there. In addition, the number of assigned output tags has an impact on performance when generating the CFCs.

Limits for cause inputs and effect outputs

Due to the system load from the visualization of the values, we recommend you create a total of no more than 250 effect outputs for each matrix.

Adding outputs to effects

To assign a new output to an effect, open the shortcut menu of the effect and select the function "Add Output Tag".

To assign an output interconnection to the created output tag, open the shortcut menu of the output tag and select "Select Output Tag...".

In the "Output Tag Selection" window, you can assign the output tag the output interconnection of an existing link or create new links with the Link Editor.

See also

"Cause Details" dialog - "Configuration" tab (Page 58)

5.2.2 Message configuration

5.2.2.1 Overview for configuring messages

Message configuration for Logic Matrix and for individual causes and effects

You can configure messages for the entire Logic Matrix as well as messages for individual causes and effects. The blocks will provide the following messages:

Matrix block:
- Degraded voting active
- Cause active
- Cause Warning active
- Cause Bypass active
- Effect active
• Effect Warning active
• Effect Bypass active

**Cause block:**
• Enable
• Limit / Deviation / Gradient active
• Bypass active
• Reset request
• First-in group active
• Tag active
• Tag simulated
• Tag bad (QC)

**Effect block:**
• Active
• Pre-alarm override active
• Bypass/override active
• Override error
• Reset request

You can configure these alarm profiles as follows:
• Enable or disable individual messages of a block type centrally
• Enable or disable all the messages of a block type centrally
• Enable or disable individual messages of a block
• Enable or disable all the messages of a block
• Change message properties

**See also**

"Cause Details" dialog - "Configuration" tab (Page 58)
"Effect Details" dialog - "Configuration" tab (Page 64)
5.2.3 OS interface

Requirements for generating block icons

The Logic Matrix CFC must be generated before the block icons for the Logic Matrix can be generated. Generating the matrix CFC in the Logic Matrix Editor places the matrix block to which the icon is attached in the program.

User permissions

You configure the user permissions in the "Authorization OS" tab of the "Matrix Properties" dialog or in the "Authorization OS" tab of the "Details" dialog box of the causes and effects.

See also

"Properties" dialog box of the Logic Matrix (Page 50)
"Cause Details" dialog - "Authorization OS" tab (Page 62)
Transferring the Logic Matrix to the project (Page 103)

5.3 Editing the properties of the Logic Matrix

5.3.1 "Properties" dialog box of the Logic Matrix

"Properties" dialog box of the Logic Matrix

Select the menu command Edit > Properties.... The "Matrix Properties" dialog box is opened with the "General" tab.

"Common" tab

Title

Enter a title to serve as the Logic Matrix designation. This is displayed in the information area of the Logic Matrix properties.

Description

Enter a process-related description of the Logic Matrix. The description is displayed in runtime in the standard view of the matrix faceplate. A maximum of 2000 characters is permitted for the description.

Comment

Enter general comments for this specific Logic Matrix. The text is assigned to the Logic Matrix block in the CFC as block comment. A maximum of 80 characters is permitted for the comment.
5.3 Editing the properties of the Logic Matrix

**Generation settings:**

**Plant hierarchy**
The hierarchy folder in which the matrix CFC is created in the project is selected here.

**CFC Name**
The name of the CFC into which the matrix is generated is displayed here.

**CPU Station**
The CPU for which the matrix CFC is created is displayed here.

**Number of startup cycles**
The number of startup cycles is set here. The value is entered at the RunUpCyc I/O and controls the time for the startup characteristics of the Logic Matrix blocks. You can find more information on the function of this I/O in the Advanced Process Library manual.

**Matrix cycle time**
The cyclic interrupt OB in which the matrix CFC should be installed is selected here. The desired time can be selected from the available settings in the drop-down menu. These cycle times are associated with the configured execution times of OB 30 to OB 38.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symbolic names for cyclic interrupt OBs</strong></td>
</tr>
<tr>
<td>A symbolic name may not be assigned for the OB into which the matrix CFC is to be installed when using the Simatic Logic Matrix.</td>
</tr>
</tbody>
</table>

**Block icon**
The Logic Matrix offers a variety of block icons for automatic installation into the corresponding picture. The number of the block icon to be generated is entered here. If this field is empty, block icon 1 is generated automatically.

You can find more information on block icons in the section Block icons for LM_Matrix (Page 117).

**Intersection DB**
This specifies the data block where the matrix stores its information.

**"Version" tab**
Here you activate the change monitoring and can view the change log.

If the "Enable change management" function is selected, every time you save, a window appears in which the changes can be documented.
### "Statistics" tab

Contains information regarding the usage statistics:

- Number of causes
- Number of effects
- Number of intersections
- Number of POs used
- Number of process tags found
- Number of available tag types.

### "Alarms" tab

Here the messages can be configured globally for all causes and effects as well as the matrix. Additionally, the messages can be adapted to individual causes and effects if required.

The Cause, Matrix, and Effect areas have the same structure.

#### Enable messages

The messages for causes, effects and the matrix are enabled with the "Enable messages" check box.

#### Messages

The individual messages of the blocks can be enabled and disabled in the "Messages" field:

<table>
<thead>
<tr>
<th>Cause</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Cause block is to signal when cause is active.</td>
</tr>
<tr>
<td>Limit / Deviation / Gradient active</td>
<td>Cause block is to signal when the warning level of an analog value is violated.</td>
</tr>
<tr>
<td>Bypass active</td>
<td>Cause block is to signal when bypass is active.</td>
</tr>
<tr>
<td>Reset request</td>
<td>Cause block is to signal when a reset is required.</td>
</tr>
</tbody>
</table>
First-in group active Cause block is to signal when it has the "First Out Alarm Group" pointer.
Tag active Cause block is to signal when a digital value is active.
Tag simulated Cause block is to signal when an input value is in simulation.
Tag bad (QC) Cause block is to signal when an input value supplies a bad quality code.

Matrix
Degraded voting active Matrix block is to signal when Degraded Voting is active.
Cause active Matrix block is to signal when a cause is active.
Cause Warning active Matrix block is to signal when the warning for a cause is active.
Cause Bypass active Matrix block is to signal when a bypass is active for a cause.
Effect active Matrix block is to signal when an effect is active.
Effect Warning active Matrix block is to signal when the warning for an effect is active.
Effect Bypass active Matrix block is to signal when a bypass is active at an effect.

Effect
Active Effect block is to signal when an effect is active.
Pre-alarm override active Effect block is to signal when the pre-warning time for an override is active.
Bypass/override active Effect block is to signal when bypass/override is active.
Override error Effect block is to signal when ...
Reset request Effect block is to signal when a reset is required.

Enable message status update
This check box corresponds to the function of Feature bit 22 of the APL. You can find more information on the function of this I/O in the Advanced Process Library manual.

"Authorization OS" tab
In this tab you configure the user permissions, which means the assignment of the Logic Matrix functions to a permission level in the PCS 7 OS.

You create the users and their individual authorization levels in the PCS 7 OS with the "User Administrator" editor.

The default authorization levels in the user administration and their values can be seen in the following table:

<table>
<thead>
<tr>
<th>Operator authorization level in the user administration</th>
<th>Value of &quot;Operator authorization level&quot; property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator inputs</td>
<td>1</td>
</tr>
<tr>
<td>Higher order operator inputs</td>
<td>2</td>
</tr>
<tr>
<td>Highest order operator inputs</td>
<td>3</td>
</tr>
<tr>
<td>Extended operator input 1</td>
<td>4</td>
</tr>
<tr>
<td>Extended operator input 2</td>
<td>5</td>
</tr>
</tbody>
</table>

The following applies to all functions: Permission level 0 means "no access protection", which means every operator has this permission. If "Enable" is not activated, the function has no operator authorization.
The table below provides an overview of the monitoring and operator control functions and their default permission levels in the Logic Matrix.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Default user level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset</td>
<td>Operator authorization level with which the operator can reset the cause.</td>
<td>2</td>
</tr>
<tr>
<td>Bypass</td>
<td>Operator authorization level with which the operator can set the bypass for this cause.</td>
<td>2</td>
</tr>
<tr>
<td>Bypass tag</td>
<td>Operator authorization level with which the operator can set the bypass for the input tag of the cause.</td>
<td>2</td>
</tr>
<tr>
<td>Reset initial value detection</td>
<td>Operator authorization level with which the operator can reset an active &quot;First Alarm Out&quot; selection for the cause</td>
<td>2</td>
</tr>
<tr>
<td>Delay time</td>
<td>Operator authorization level with which the operator can change the delay time for the analog input tag.</td>
<td>2</td>
</tr>
<tr>
<td>Deviation limit</td>
<td>Operator authorization level with which the operator can change the deviation value for the cause's deviation.</td>
<td>2</td>
</tr>
<tr>
<td>Deviation limit hysteresis</td>
<td>Operator authorization level with which the operator can change the hysteresis for the deviation limit for the cause.</td>
<td>2</td>
</tr>
<tr>
<td>Deadband</td>
<td>Operator authorization level with which the operator can change the deadband of the analog value for the cause.</td>
<td>2</td>
</tr>
<tr>
<td>Enable/disable simulation</td>
<td>Operator authorization level with which the operator can activate the simulation for the digital input tag.</td>
<td>3</td>
</tr>
<tr>
<td>Simulation value</td>
<td>Operator authorization level with which the operator can change the simulation value for the digital input tag.</td>
<td>1</td>
</tr>
<tr>
<td>Flutter time [s]</td>
<td>Operator authorization level with which the operator can change the flutter suppression time for the digital input tag.</td>
<td>2</td>
</tr>
<tr>
<td>Alarm limit</td>
<td>Operator authorization level with which the operator can change the alarm limit for the analog input tag.</td>
<td>2</td>
</tr>
<tr>
<td>Warning limit</td>
<td>Operator authorization level with which the operator can change the warning limit for the analog input tag.</td>
<td>2</td>
</tr>
<tr>
<td>Hysteresis limit</td>
<td>Operator authorization level with which the operator can change the hysteresis for the limits of the analog input tag.</td>
<td>2</td>
</tr>
<tr>
<td>Gradient up</td>
<td>Operator authorization level with which the operator can change the high gradient limit for the analog input tag.</td>
<td>2</td>
</tr>
</tbody>
</table>
### 5.3 Editing the properties of the Logic Matrix

Operator authorizations can also be adapted object-by-object in the properties of the individual causes and effects as needed.

#### Display settings tab

The display of the Logic Matrix faceplate is adapted here. If the respective row or column is enabled, it is displayed in the visualization.

The setting enables users to optimize the display of the faceplate according to their specific needs.

The setting has no effect on the Logic Matrix Editor.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Default user level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gradient down</td>
<td>Operator authorization level with which the operator can change the low gradient limit for the analog input tag.</td>
<td>2</td>
</tr>
<tr>
<td>Gradient hysteresis</td>
<td>Operator authorization level with which the operator can change the hysteresis for the gradients of the analog input tag.</td>
<td>2</td>
</tr>
<tr>
<td>Gradient lag time [s]</td>
<td>Operator authorization level with which the operator can change the delay time for the analog input tag.</td>
<td>2</td>
</tr>
<tr>
<td>Gradient reset</td>
<td>Operator authorization level with which the operator can reset the gradient values for the analog input tag.</td>
<td>1</td>
</tr>
<tr>
<td><strong>Matrix</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset visible causes</td>
<td>Operator authorization level with which the operator can use the button for resetting the displayed causes</td>
<td>2</td>
</tr>
<tr>
<td>Reset visible effects</td>
<td>Operator authorization level with which the operator can use the button for resetting the displayed effects</td>
<td>2</td>
</tr>
<tr>
<td><strong>Effect</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset</td>
<td>Operator authorization level with which the operator can reset the effect.</td>
<td>2</td>
</tr>
<tr>
<td>Bypass</td>
<td>Operator authorization level with which the operator can set the bypass for the effect.</td>
<td>2</td>
</tr>
<tr>
<td>Override</td>
<td>Operator authorization level with which the operator can set the override for the effect.</td>
<td>2</td>
</tr>
<tr>
<td>Override time</td>
<td>Operator authorization level with which the operator can change the override time for the effect.</td>
<td>2</td>
</tr>
<tr>
<td>Override pre-warning time</td>
<td>Operator authorization level with which the operator can change the pre-warning time for the override for this effect.</td>
<td>2</td>
</tr>
<tr>
<td>Delay time</td>
<td>Operator authorization level with which the operator can change the delay time for this effect.</td>
<td>2</td>
</tr>
</tbody>
</table>
5.4 Configuring the causes

5.4.1 Overview for configuring the causes

You can find information about the structure, the configurable behavior and the function of causes in the "Functions of Logic Matrix" introductory section under the heading "Cause (Page 16)".

5.4.2 Creating/changing a cause and the rows for a cause

Procedure for creating/changing a cause

Click the row and select "Add Cause" from the shortcut menu. A new cause is created. Double-click on a cell in the "Causes" configuration area of the Logic Matrix to change the text.

The shortcut menus in the "Causes" configuration area of Logic Matrix

When you click on a row in the "Input Tag" area in the "Causes" configuration area of the Logic Matrix, the shortcut menu offers the following functions:

Select Input-Tag...
Opens the window to assign a connection to the selected input tag via a link.

Direct connection ...
Opens the window for assigning the selected input tag a direct connection to a connector in the S7 program.

Add Cause Input
Adds an additional input tag to the selected cause.

Add Cause
Adds a new cause below the selected cause.

Copy Cause
Copies the selected cause to the clipboard.

Cut Cause
Cuts the selected cause and copies it to the clipboard.

**Paste Cause**
Pastes the cause from the clipboard over the currently selected cause.

**Delete Cause Input**
Deletes the selected input tag.

**Delete Cause**
Deletes the selected cause.

**Cause Details**
Opens the properties window of the selected cause.

When you right-click on a row in the "Function" area in the Causes configuration area of the Logic Matrix, the shortcut menu offers the selection of the different cause functions (AND, OR, Xoo Y). The shortcut menu only shows the cause functions that are permitted for the configured number of input tags.

See also
Transferring the Logic Matrix to the project (Page 103)

### 5.4.3 Overview of the "Cause Details" dialog

**Procedure for configuring a cause**
Click the row and select "Cause Details" from the shortcut menu or open the cause details with a click on the configuration button.

**Dialog box for configuring a cause**
The dialog box for configuring a cause contains the following tabs:
- "Configuration (Page 58)"
- "Analog parameters (Page 60)"
- "Digital parameters (Page 62)"
- "Operator authorizations (Page 62)"
The display of the individual tabs will differ depending on how many tags you have created and their tag type (analog or digital).
5.4.4 "Cause Details" dialog - "Configuration" tab

"Configuration" tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td><strong>Group:</strong> In this field, you can assign a value as filter criterion for the different causes of the Logic Matrix.</td>
</tr>
<tr>
<td>First out group:</td>
<td><strong>Group:</strong> Here you can assign the cause to a First out group.</td>
</tr>
<tr>
<td>Voting</td>
<td>Here you can adapt the cause response.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Bad input value for bad signal status:</strong> When this option is enabled, a value with bad signal status is considered bad.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Enable degraded voting:</strong> Activate &quot;Degraded Voting&quot; function. You can find a description of the functions in the section &quot;Cause (Page 16) &quot;.</td>
</tr>
<tr>
<td>Function type</td>
<td>Different functions are available depending on the number of input tags:</td>
</tr>
<tr>
<td></td>
<td>- <strong>OR</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>AND</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>XooY</strong></td>
</tr>
<tr>
<td>Bypass</td>
<td>Use the &quot;...&quot; button to assign a bypass tag to the cause. This tag activates the bypass function of the cause.</td>
</tr>
<tr>
<td></td>
<td>If a bypass tag is assigned to the cause, the bypass can no longer be activated by the operator in runtime.</td>
</tr>
<tr>
<td>Cause timing</td>
<td>You set the time response of the cause in this area:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Mode:</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>No delay</strong> No time response set.</td>
</tr>
<tr>
<td></td>
<td>- <strong>On delay</strong> Cause with on delay: The cause function must be fulfilled for the time configured in the &quot;Time:&quot; field until the cause becomes bad.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Off delay</strong> Cause with off delay: The cause will not become good until the cause function is not fulfilled for the time configured in the &quot;Time:&quot; field.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Timed</strong> Timed cause: The cause is always bad for the time configured in the &quot;Time:&quot; field, regardless of whether the cause function is fulfilled for a longer or shorter period of time.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Time:</strong> Time specification for block modes.</td>
</tr>
<tr>
<td></td>
<td>See section &quot;Timing (Page 21)&quot; for an illustration of the different modes.</td>
</tr>
<tr>
<td>Deviation limit</td>
<td>In this area, you can activate and adapt the response of the cause in the case of analog values with the &quot;Deviation&quot; function.</td>
</tr>
<tr>
<td></td>
<td>The function is enabled with &quot;Enable deviation limit&quot;. The &quot;Limit&quot; field specifies the limit and a hysteresis can be specified in the &quot;Hysteresis&quot; field.</td>
</tr>
<tr>
<td></td>
<td>You can find a description of the functions in the section &quot;Analog input deviation (Page 18)&quot;.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
**Features** | In this area, you can influence the response of the cause.  
- **Signal value = 0, if limit is violated:**  
  If this option is selected, the output of the cause block is low active. If the limit is exceeded, the output is set to 0. The output does not affect the function of the matrix and serves to interconnect the "Cause active" information in the program.  
- **Cause auto reset:**  
  If this option is selected, the cause is reset automatically when the trigger condition is no longer fulfilled.  
- **Trip on deviation is violated:**  
  This setting only has an effect when monitoring of the deviation limit is enabled. If this option is active, the cause is triggered as soon as the configured deviation limit is exceeded.  
- **Trip on gradient is violated:**  
  If this option is enabled, the cause is enabled when the configured gradient limit is exceeded.  
- **Only one tag can be bypassed:**  
  If this option is selected, only one input tag of the cause can be bypassed at a time.  
- **Only one tag can be simulated:**  
  If this option is selected, only one input tag of the cause can be simulated at a time.

**Comment** | A comment for the cause can be specified here. This comment is visible in the OS faceplate of the matrix for this cause. A maximum of 80 characters is permitted.

**Messages** | Possible settings for message and alarm response of the block:  
- **Use matrix settings:**  
  When this option is enabled, the settings from the properties of the matrix are applied to the cause. The remaining check boxes in the "Messages" field can then not be edited.  
  If the option is disabled, a custom message response can be made for the cause independent of the settings of the matrix.  
  Refer to the "Messages" tab" heading in the "Properties" dialog box of the Logic Matrix (Page 50)" section for a description of the message settings.
"Cause Details" dialog - "Analog parameters" tab

"Analog parameter" tab

Up to three columns are displayed in this tab for value input. The display is dependent on the number of analog input tags configured for the cause.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation scale high</td>
<td>Upper OS display range for the value</td>
</tr>
<tr>
<td>Operation scale low</td>
<td>Lower OS display range for the value</td>
</tr>
<tr>
<td>Unit</td>
<td>The unit of the analog value is entered as text in this field. The entered text is used for the display in the Logic Matrix.</td>
</tr>
</tbody>
</table>
| Format            | In this field you specify how the analog value is displayed in the matrix. The display is based on the format instruction for user-defined number format character strings in C#.
A 0 is a 0 placeholder: If the place exists in the value, the value is displayed; if not, a 0 is displayed.
A # is a number placeholder. If there is a numeral at this place in the value, the value will be displayed. If not, nothing is displayed.
A . is the decimal separator
A , is a thousands separator
Example:
The value is 1234.56. The formatting has the following effects on the value:
#####.### > 1234.56
00000.000 > 01234.560
0,000 > 1,234
0.# > 1234.6

<table>
<thead>
<tr>
<th>Enable alarm limit</th>
<th>You activate the alarm limit for the input tag in this field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm limit</td>
<td>The value entered in this field is the alarm limit for the analog value. This limit has an effect on the state of the input tags. Depending on the setting in the &quot;Alarm limit type&quot; field, the input tag is considered enabled when there is a high or low limit violation of the value.</td>
</tr>
<tr>
<td>Enable warning limit</td>
<td>You can enable the warning limit for the input tag in this field.</td>
</tr>
<tr>
<td>Warning limit</td>
<td>The value entered in this field is the warning limit for the analog value. This limit has no effect on the cause, but it can generate a message when the limit is enabled. The setting in the &quot;Alarm limit type&quot; field determines whether it is a low limit (active when the value is undershot) or high limit (active when the value is exceeded).</td>
</tr>
<tr>
<td>Alarm limit type</td>
<td>This setting specifies whether the limits are high or low limits. High limit: Input tag is enabled for: Value &gt;= &quot;Limit&quot; Low limit: Input tag is enabled for: Value &lt;= &quot;Limit&quot;</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hysteresis limit</td>
<td>The hysteresis specifies a deadband in the range of the limit value that applies if a cause tag no longer satisfies the tripping condition. It prevents an input from constantly oscillating between active and inactive. The default setting is no hysteresis, i.e., the value &quot;0&quot;.</td>
</tr>
<tr>
<td></td>
<td>Up: Limit is enabled with: &quot;Value&quot; &gt;= &quot;Limit&quot;</td>
</tr>
<tr>
<td></td>
<td>Limit is disabled with: &quot;Value&quot; &lt;= (&quot;Limit&quot;-&quot;Hysteresis&quot;)</td>
</tr>
<tr>
<td></td>
<td>Down: Limit is enabled with: &quot;Value&quot; &lt;= &quot;Limit&quot;</td>
</tr>
<tr>
<td></td>
<td>Limit is disabled with: &quot;Value&quot; &gt;= (&quot;Limit&quot;+&quot;Hysteresis&quot;)</td>
</tr>
<tr>
<td>DeadBand</td>
<td>The deadband suppresses values hovering around the zero point.</td>
</tr>
<tr>
<td>Enable gradient up</td>
<td>Enables monitoring of the process value slew rate.</td>
</tr>
<tr>
<td>Gradient up</td>
<td>Limit of the slew rate.</td>
</tr>
<tr>
<td>Enable gradient down</td>
<td>Enables monitoring of the process value negative slew rate.</td>
</tr>
<tr>
<td>Gradient down</td>
<td>Limit the negative slew rate.</td>
</tr>
<tr>
<td>Gradient hysteresis</td>
<td>In this field you enter the hysteresis for the gradient.</td>
</tr>
<tr>
<td>Gradient time factor</td>
<td>Time factor for gradient calculation. It is possible to normalize the time factor for the gradient calculation by seconds, minutes and seconds. Example: Limit = 10°C, time basis = minutes -&gt; Limit = 10°C/min</td>
</tr>
<tr>
<td>Gradient lag time [s]</td>
<td>A P-T1 filter can be used to filter the process value prior to the formation of the gradient. The delay time is the time constant of the filter.</td>
</tr>
</tbody>
</table>

**Note**

**Gradients**

To prevent exceeding the gradients when starting the controller, the gradient for the number of cycles configured at the "RunUpCyc" I/O is set to 0.

**See also**

Overview for configuring the causes (Page 56)
5.4.6 "Cause Details" dialog - "Digital parameters" tab

"Digital parameters" tab

Up to three columns are displayed in this tab for value input. The display is dependent on the number of analog input tags configured for the cause.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm limit type</td>
<td>Specifies the tripping type of the value:</td>
</tr>
<tr>
<td></td>
<td>● 1 enabled (ETT): The input tag is enabled when the input signal is &quot;true&quot;.</td>
</tr>
<tr>
<td></td>
<td>● 0 enabled (DTT): The input tag is enabled when the input signal is &quot;false&quot;.</td>
</tr>
<tr>
<td>Flutter enable</td>
<td>This setting activates the flutter suppression for the digital value.</td>
</tr>
<tr>
<td>Flutter time [s]</td>
<td>The value entered in this field is the time for the flutter suppression. The input tag must be enabled or disabled for at least the specified time with activated flutter suppression so that the value change is applied to the cause.</td>
</tr>
</tbody>
</table>

See also

"Properties" dialog box of the Logic Matrix (Page 50)
Overview for configuring the causes (Page 56)
The tags of the Logic Matrix (Page 46)
Definition of terms (Page 12)

5.4.7 "Cause Details" dialog - "Authorization OS" tab

"Operator authorizations"

You can adapt the operator authorization levels for this cause in this tab.

If the "Use matrix settings" option is enabled, the settings from the properties of the matrix are applied for the cause.
If the option is disabled, separate user authorizations can be assigned to the cause independent of the settings of the matrix.
For a description of the operator authorizations, refer to the section ""Authorization OS" tab (Page 50)". 
5.5 Configuring the effects

5.5.1 Overview for configuring the effects

You can find information about the structure, the configurable behavior and the function of effects in the "Functions of Logic Matrix" introductory section under the heading "Effect (Page 23)".

5.5.2 Creating/changing an effect and the column for an effect

Procedure for creating/changing an effect

Click the row and select "Add Effect" from the shortcut menu. A new effect is created. Double-click on a cell in the Effects configuration area of the Logic Matrix to change the text.

Shortcut menu in the "Effects" configuration area of the Logic Matrix

When you click on a column in the "Output Tag" area in the "Effects" configuration area of the Logic Matrix, the shortcut menu offers the following functions:

Select Output Tag...
Opens the window to assign a link to the selected output tag

Direct connection ...
Opens the window for assigning the selected output tag a direct connection to a connector in the S7 program.

Add Effect Output
Adds an additional output tag to the selected effect

Add Effect
Adds a new effect to the right of the selected effect

Copy Effect
Copies the selected effect to the clipboard.

Cut Effect
Cuts the selected effect and copies the effect to the clipboard.

Paste Effect
Pastes the effect from the clipboard over the currently selected effect.

Delete Effect Output
Deletes the selected output tag

Delete Effect
Deletes the selected effect
5.5 Configuring the effects

Effect Details ...
Opens the properties window of the selected effect

See also
Transferring the Logic Matrix to the project (Page 103)

5.5.3 Overview of the "Effect Details" dialog box

Procedure for configuring an effect
Click the column and select "Effect Details ..." from the shortcut menu or open the cause details with a click on the configuration button .

Dialog box for configuring an effect
The dialog box for configuring an effect contains the following tabs:

- "Configuration (Page 64)"
- "Operator authorizations (Page 65)"

5.5.4 "Effect Details" dialog - "Configuration" tab

"Configuration" tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>In this field, you can assign a value as filter criterion for the different effects of the Logic Matrix.</td>
</tr>
<tr>
<td>Mode</td>
<td>Specifies the tripping type of the effect:</td>
</tr>
<tr>
<td></td>
<td>• 0 enabled (DTT)</td>
</tr>
<tr>
<td></td>
<td>• 1 enabled (ETT)</td>
</tr>
<tr>
<td></td>
<td>The description of the tripping types can be found in section Definition of terms (Page 12).</td>
</tr>
<tr>
<td>Bypass</td>
<td>Use the &quot;...&quot; button to assign a bypass tag to the effect. This tag activates the bypass function of the effect.</td>
</tr>
<tr>
<td></td>
<td>If a bypass tag is assigned to the effect, the bypass can no longer be activated by the operator in runtime.</td>
</tr>
<tr>
<td>Override</td>
<td>An override tag can be assigned to the effect using the &quot;...&quot; button. This tag activates the override function of the effect.</td>
</tr>
<tr>
<td></td>
<td>If an override tag is assigned to the effect, the override can no longer be activated by the operator in runtime.</td>
</tr>
</tbody>
</table>
### Field Description

**Reset**
A reset tag can be assigned to the effect using the "..." button. This tag resets the effect.
The input is edge-controlled.

**Cause timing**
You set the time response of the effect in this area:
- **Mode:**
  - **No delay**
    No time response set
  - **On delay**
    Effect with on delay: The nodes must be fulfilled for the time configured in the "Time" field until the effect trips.
  - **Off delay**
    Effect with off delay: The effect is not revoked until the node for the time configured in the "Time" field is not fulfilled.
  - **Timed**
    Timed effect: The effect is always tripped for the time configured in the "Time" field regardless of whether the node is enabled for a longer or shorter period of time.
- *Time:
  Time specified for the block modes.

See section "Time response (Page 26)" for an illustration of the different modes.

**Override time**
Time settings for the override function
- **Time:**
  Setting for the time that the override function is to override the effect.
- **Pre-warning time:**
  Setting for pre-warning time of message before override is canceled.

**Comment**
A comment for the effect can be specified here. This comment is visible in the OS faceplate of the matrix for this effect. A maximum of 80 characters is permitted.

**Messages**
Possible settings for message and alarm response of the block:
- **Use matrix settings:**
  When this option is enabled, the settings from the properties of the matrix are applied to the effect. The remaining check boxes in the "Messages" field can then not be edited.
  If the option is disabled, a custom message response can be made for the effect independent of the settings of the matrix.
  Refer to the ""Messages" tab" heading in the ""Properties" dialog box of the Logic Matrix (Page 50)" section for a description of the message settings.

### 5.5.5 "Effect Details" dialog - "Authorization OS" tab

**"Operator authorizations"**
You can adapt the operator authorization levels for this cause in this tab.
If the "Use matrix settings" option is enabled, the settings from the properties of the matrix are applied for the cause.
If the option is disabled, separate user authorizations can be assigned to the cause independent of the settings of the matrix.
For a description of the operator authorizations, refer to the section "Authorization OS" tabHotspot-Text.

See also

"Properties" dialog box of the Logic Matrix (Page 50)
Overview for configuring the effects (Page 63)
"Intersection details" dialog box - "Configure" tab (Page 76)
The tags of the Logic Matrix (Page 47)

5.6 Configuring the links

5.6.1 Overview for creation of links

Introduction

The Link Editor is used to create the cause and effect links to the input/output tags. Links define the interconnections between the cause/effect blocks of the Logic Matrix and the process tags in the project.

There are 3 different link types:
- Digital input - links for digital causes
- Analog input - links for analog causes
- Output - Links for effects

A link defines the connections of the input/output tag, i.e. the interconnections to the blocks and their connectors, that are created in the instances.

A link always consists of a connection which is mandatory (it supplies the signal to be monitored for causes, or the signal to be controlled for effects) and, depending on the type of link, of additional optional connections. Connections are created as interconnections in the chart during the generation. Additional information on the function

Possible connections of the various links:

Analog cause link:
An analog cause link has several interconnectable inputs and outputs. The Ana input must be interconnected to the input which the cause should monitor. The other inputs and outputs can be used to receive information from other blocks or to pass it on to other blocks.

Ana: Interconnection to the signal source of the input tag (required)
Ana_Byp: Interconnectable input for setting the bypass of the input tag
Ana_Unit: Unit of Ana
Ana_OpScale: Scale of Ana
Ana_Al_Lim: Alarm limit of Ana
Ana_Wn_Lim: Warning limit of Ana
Ana_Hyst: Hysteresis of limits of Ana
Ana_GradUpLim: Limit for upper gradient of Ana
Ana_GradDnLim: Limit for lower gradient of Ana
Ana_GradHys: Hysteresis of gradients of Ana
Ana_Byp_Out: Output of the bypass state of Ana
Ana_Al_Out: Output of the configured alarm limit of Ana
Ana_Wn_Out: Output of the configured warning limit of Ana
Ana_Hys_Out: Output of the configured hysteresis of Ana
Ana_Grad: Output of the current gradient value of Ana
Ana_GradPP: Output of the maximum positive gradient value of Ana
Ana_GradNP: Output of the maximum negative gradient value of Ana
Ana_Al_Act: Output of the alarm state from Ana
Ana_Wn_Act: Output of the warning state of Ana
Ana_Dev_Act: Issue of deviation state of Ana
Ana_GradUpAct: Output of the upper gradient state of Ana
Ana_GradDnAct: Output of the lower gradient state of Ana
5.6 Configuring the links

Image 5-2  Link for analog cause

Digital cause link:
A digital cause link has only one interconnectable input and two outputs. The \texttt{Dig} input must be interconnected to the input which the cause should monitor. Both outputs can be used to pass information on to other blocks.

- \texttt{Dig}: Interconnection to the signal source of the input tag (required)
- \texttt{Dig\_Byp}: Interconnectable input for setting the bypass of the input tag
- \texttt{Dig\_Out}: Output of value of \texttt{Dig}
- \texttt{Dig\_Byp\_Out}: Output of the bypass state of the input tag
- \texttt{Dig\_Al\_Act}: Output of the alarm state of \texttt{Dig}

\textbf{Effect link:}

An effect link has only one interconnectable output. This \texttt{Out} output must be interconnected to the target upon which the effect should act. Using alternative or additional interconnections...

![Image 5-3 Link for digital cause](Image
description)
of this output, an effect link can act on multiple inputs, or be interconnected to a freely available input from a selection of multiple inputs.

Out: Effect output (mandatory)

BypAct: Output of the bypass state of the effect

**Image 5-4**  Link for effect

**Link Editor**

To open the link editor, select "Edit > Links...".

**See also**

Interconnection of the Logic Matrix with process tags (control modules) (Page 28)
5.6.2 Overview of the "LinkEditor" dialog box

Procedure for configuring a link

Open the Link Editor with "Edit > Links...".

The Link Editor window

The window for cause and effect has the same structure.

- You use the tabs ① in the Link Editor to select whether a link is to be created for a cause or an effect.

- In the left area ② of the Link Editor, you can create new links and copy or delete existing links. By means of the list, existing links can be opened and edited by selecting the link in this area. The link can then be edited in the right area of the Link Editor. In addition, the list contains the information about whether it is an analog or digital link.

The right area of the Link Editor is divided into two areas:

- You enter the name of the link in the upper General section ③ and determine for cause links if the link is an analog or digital link. An Effect link is always digital. In the "Displayed name OS" field, you can enter an alternative name to be shown in Runtime instead of the link name.

- You define the connection information for the link in the lower area ④ of the Link Editor. Here, you specify the inputs and outputs of the cause or effect block that are to be connected to specific block inputs or outputs in the charts defined in the "Scope" area. A text can be assigned for the output of the effect in this area. This text is displayed in the interlock faceplate when the link is interconnected to an interlock block. There, it can be used to better determine where the respective interlock originated.

- Use the Commit button to apply the changes and inputs in the right area.
Note

Default link

If all links are deleted, a default link is created in the list in the left pane. The default link can be processed as a normal link or deleted as soon as another link is created.

The scope of the link

The criteria for the scope have the following function:

- An individual chart of the project can be selected with process tag. If anything is selected in this column, the link is only effective for this individual CFC.
- The validity of the link can be applied to one or more process tag types or control module types in the Process tag type column. The link can then be used for all charts of this type.
NOTICE

Multiple scopes

A scope can be defined by several criteria (rows).
In the subsequent definition of the connections between the cause/effect block and block of the process tag, the only blocks offered are the ones which meet all the criteria of the scope.
A typical application would be, for example, an interlock which is to be driven by an effect.
The interlock could act on different motor and valve process tag types, all of which contain an interlock block of the same type with the same block name.
If incorrect criteria are selected that do not match (for example, two tag types that do not contain the same block types with the same block name), no connections can be defined.

The selection in this area determines which blocks and I/Os can be selected for the connections and therefore serves as signal source for the input tag of a cause or as target for the output tag of an effect.

The connection information of the link

The connection information area shows the user-relevant inputs and outputs of the cause and effect blocks. The information displayed in this area depends on the selection "Effect", "Digital cause" or "Analog cause".

The assignment to the block connectors of the charts defined under Scope takes place here.
The connector identified by an asterisk (*) must always be interconnected to a block connector because this information is required for the Logic Matrix function. For Cause blocks, this is the value of the input tag; for Effect blocks it is the value of the output tag. All other connectors include additional information.

To define a interconnection in a link, you first select a block in the "Block" drop-down menu.
This drop-down menu includes the blocks that exist in all charts defined in the Scope area.
In the "Connector" drop-down menu, you then select the block connector required for the interconnection. Only the connectors of the selected block that can be used for this interconnection are displayed.

If you want to invert the interconnection, select the "Inverted" check box.

You can use the "Add additional link" button to realize an additional connection from an output of the cause/effect block. Use the "Remove additional link" button to remove the selected additional link. This can be used, for example, to generate a message via an ExtMsg connector in addition to an interlock for the effect.

The Effect view also has the "Add alternative link" and "Remove alternative link" buttons. An alternative connection is required when the input in the target chart is used. The normal application for this is interlocking blocks. Here you can specify the interlocking inputs as alternative link. If the first interlocking input is already being used, the interconnection is established to the next available alternative connector. Once an available connector is found, the remaining connectors are ignored. Use the "Remove alternative link" button to remove a selected alternative link.
### Digital link

<table>
<thead>
<tr>
<th>Block Connector</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dig*</td>
<td>Digital process value of the input tag</td>
</tr>
<tr>
<td>Dig_Byp</td>
<td>Signal for bypassing the input tag</td>
</tr>
<tr>
<td>Dig_Out</td>
<td>Output of the digital process value</td>
</tr>
<tr>
<td>Dig_Byp_Out</td>
<td>Signal status for bypassing the input tag</td>
</tr>
<tr>
<td>Dig_AI_Act</td>
<td>State of the digital process value</td>
</tr>
</tbody>
</table>

### Analog link

<table>
<thead>
<tr>
<th>Block Connector</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ana*</td>
<td>Analog process value of the input tags</td>
</tr>
<tr>
<td>Ana_Byp</td>
<td>Signal for bypassing the input tag</td>
</tr>
<tr>
<td>Ana_Unit</td>
<td>Unit of the analog process value</td>
</tr>
<tr>
<td>Ana_OpScale</td>
<td>Scale of the analog process value</td>
</tr>
<tr>
<td>Ana_AI_Lim</td>
<td>Alarm limit of the analog process value</td>
</tr>
<tr>
<td>Ana_Wn_Lim</td>
<td>Warning limit of the analog process value</td>
</tr>
<tr>
<td>Ana_Hyst</td>
<td>Hysteresis of the analog process value</td>
</tr>
<tr>
<td>Ana_GradUpLim</td>
<td>Limit for upper gradient of the analog process value</td>
</tr>
<tr>
<td>Ana_GradDnLim</td>
<td>Limit for lower gradient of the analog process value</td>
</tr>
<tr>
<td>Ana_GradHys</td>
<td>Hysteresis for gradient of the analog process value</td>
</tr>
<tr>
<td>Ana_Byp_Out</td>
<td>Signal status for bypassing the input tag</td>
</tr>
<tr>
<td>Ana_AI_Out</td>
<td>Output of the alarm limit of the analog process value</td>
</tr>
<tr>
<td>Ana_Wn_Out</td>
<td>Output of the warning limit of the analog process value</td>
</tr>
<tr>
<td>Ana_Hys_Out</td>
<td>Output of the hysteresis of the analog process value</td>
</tr>
<tr>
<td>Ana_Grad</td>
<td>Output of the gradient of the analog process value</td>
</tr>
<tr>
<td>Ana_GradPP</td>
<td>Output of the positive gradient of the analog process value</td>
</tr>
<tr>
<td>Ana_GradNP</td>
<td>Output of the negative gradient of the analog process value</td>
</tr>
<tr>
<td>Ana_AI_Act</td>
<td>State of the alarm limit of the digital process value</td>
</tr>
<tr>
<td>Ana_Wn_Act</td>
<td>State of the warning limit of the digital process value</td>
</tr>
<tr>
<td>Ana_Dev_Act</td>
<td>State of the deviation monitoring of the digital process value</td>
</tr>
<tr>
<td>Ana_GradUpAct</td>
<td>State of the positive gradient of the process value</td>
</tr>
<tr>
<td>Ana_GradDnAct</td>
<td>State of the negative gradient of the process value</td>
</tr>
</tbody>
</table>

### Analog link

<table>
<thead>
<tr>
<th>Block Connector</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Out*</td>
<td>Output value of the output tag</td>
</tr>
<tr>
<td>BypAct</td>
<td>Bypass state of the effect</td>
</tr>
</tbody>
</table>
5.6.3 Creating a new Cause link

Cause link

1. To create a new cause link, open the Link Editor and go to the "Cause Links" tab.
2. Use the "Add new link" button to create a new blank link.
3. Enter a unique name for this link in the "Name:" field.
4. Select if this link is an Analog link or a Digital link.
5. Specify the scope of the link under "Scope".
6. Link at least the connector identified by an asterisk (*) with a connector.
7. Link additional connectors, if necessary, when you transfer additional information to the cause or when you want to read from the cause. The use of the connectors is described in the section Overview of the "LinkEditor" dialog box (Page 71).
8. Confirm your entries with "Commit".
9. You can now select a tag with "Select Input Tag" to which the scope of the link that you have just created applies. During generation, the cause block is now connected with the defined connectors in the selected chart.

5.6.4 Creating a new Effect link

Effect link

1. To create a new effect link, open the Link Editor and go to the "Effect Links" tab.
2. Use the "Add new link" button to create a new blank link.
3. Enter a unique name for this link in the "Name" field.
4. Specify the scope of the link under "Scope".
5. Link the connector identified by an asterisk (*) with a connector.
6. Link additional connectors, if necessary, by adding additional or alternative links.
7. Confirm your entries with "Commit".
8. You can now select a tag with "Select Output Tag" for which the scope of the link that you have just created applies. During generation, the effect block is now connected with the defined connectors in the selected chart.
5.7 Configuring the intersections

5.7.1 Editing or changing intersections

Editing or changing an intersection

Select a valid intersection cell in the intersection of a configured cause and a configured effect.

Note
Each logic matrix supports up to 1024 intersections.

Procedure for editing/changing an intersection

Open the shortcut menu in the Intersections configuration area of the Logic Matrix by right-clicking an intersection.
You can assign the parameters of the interface function in the shortcut menu.

Shortcut menu in the intersection configuration area of the Logic Matrix

When you click on an intersection in the intersection configuration area of the Logic Matrix, the shortcut menu offers the following functions:

- N - Not stored
- S - Stored
- V - Overridable
- R - Resettable and overridable
- Delete intersection

5.7.2 "Intersection details" dialog box - "Configure" tab

Functions of the intersections

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N - Not stored</td>
<td>Simple pass through function. If the cause is active, the effect is tripped.</td>
</tr>
<tr>
<td>S - Stored</td>
<td>If the cause is active, the effect is tripped and stored. If the effect is no longer tripped, the operator must manually clear it in the Viewer or in online mode of the Engineering Tool or by setting the configured reset/override tag to TRUE.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
**V** - Overridable | If the cause is active, the effect is tripped. You can bypass the tripping of the effect by
- Manual intervention, or
- Setting the configured reset/override tag to TRUE as long as the effect is still tripped.

**R** - Resettable and overridable | This intersection type is a combination of the **S** and **V** types described above. The effects interconnected with this intersection type remain active if the associated cause becomes inactive, except that
- The override function can be used to bypass the effect as long as the cause is active.
- The effects can be acknowledged if the cause is no longer active.

None | There is no connection between this cause and this effect (no entry in the intersection). This is the default intersection type.

XooN value (2-15) | This enables you to assign causes according to the majority principle. X is entered by the user, and N is determined based on the number of intersections having X as a coefficient. Only one XooN assignment is permitted for each effect. Only intersections of the same type (for example, all **S** or all **N**) can be taken into consideration for assignment according to the majority principle.

---

**Intersection assignment according to the majority principle**

The assignment of intersections with the majority principle is done by the function "Edit In Place". This means that these intersections are not available from the shortcut menu of the intersections. They are typed directly into the appropriate cells. The number and type of intersection is typed in for this. The entry remains red until the majority principle is fulfilled.

For non-stored tripping with 2 satisfied conditions, a "2N" column must be entered in at least 2 fields. Once the condition is fulfilled, the font color changes from red to black.
5.8 Exporting/importing a Logic Matrix file

Exporting

When creating and editing Logic Matrices, it may be necessary to edit the interlock logic outside the engineering station. To meet this requirement, it is possible to export all information of the Logic Matrix in a table. This information can then be displayed and edited in a worksheet program (e.g. Microsoft Excel or Open Office Calc).

Note

Importing

After editing the exported interlock logic, it must be inserted back into the Logic Matrix Editor again. This process is referred to as "Importing a Logic Matrix".

Note

During import, the interlock logic of the Logic Matrix open in the editor is replaced with the content of the .ods file.

As a result, all the blocks in the CFC are replaced during the next generation (if a cause is deleted and recreated again, it obtains another ID, which means the corresponding block is deleted with the generation and a new one is created). Any manual adaptations to the CFC are lost.
5.8.1 Exporting a Logic Matrix file (.ods)

Procedure

To export the Logic Matrix to an .ods file, follow these steps:

- In the Logic Matrix Engineering Tool select the menu command File > Exporting... and enter the preferred name and storage location of the .ods file.

Result

The Logic Matrix Editor now generates a file of the *.ods type, which includes a collection of tables that map the interlock logic. You can now open and further process this file with the help of a spreadsheet program.

Information on the information in the file and its editing is available in the section Editing an exported Logic Matrix file (Page 79).

5.8.2 Editing an exported Logic Matrix file

Structure of the export file

After the export, you can open the .ods file with a worksheet program, such as Microsoft Excel or Open Office Calc.

The file includes several sheets which map the logic content of the matrix and in which it can be edited and extended:

- **Matrix_Configuration**: The matrix settings are shown within this worksheet. The worksheet shows the active settings in the Logic Matrix Editor under "Edit -> Properties...". The settings are displayed in tabular form.

- **Version_History**: This worksheet shows all entries of the change management if change management has been activated in the Logic Matrix Editor under "Edit -> Properties...-> Version". The worksheet is only for display and documentation and is ignored during import.

- **Cause_Configuration**: The causes of the matrix are defined in this worksheet. All properties assigned to a cause are displayed in columns. The individual causes are each defined in a row.

- **Cause_Analog_Inputs**: The analog input tags of the individual causes are defined in this worksheet. All properties assigned to an analog input tag are displayed in columns. The individual input tags are each defined in a row.

- **Cause_Digital_Inputs**: The digital input tags of the individual causes are defined in this worksheet. All properties assigned to a digital input tag are displayed in columns. The individual input tags are each defined in a row.

- **Intersections**: The links between the causes and effects are created in this worksheet.
**Effect_Configuration**: The effects of the matrix are defined in this worksheet. All properties assigned to an effect are displayed in columns. The individual effects are each defined in a row.

**Effect_Outputs**: The output tags of the individual effects are defined in this worksheet. All properties assigned to an output tag are displayed in columns. The individual output tags are each defined in a row.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>.ods file</td>
</tr>
<tr>
<td>To be able to import the edited file, the structure and the sequence of the columns within the tables may not be changed.</td>
</tr>
</tbody>
</table>

"Matrix_Configuration" worksheet

The "Matrix_Configuration" worksheet contains information on the settings in tabular form that have been made for the matrix in the Logic Matrix Editor under "Edit -> Properties...".

These settings, except for the compiling settings, can be edited in the export file and imported again.

Refer to the section "Properties" dialog box of the Logic Matrix (Page 50) for a description of the individual properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>General settings</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>• Title</td>
<td>Title to designate the Logic Matrix. This text is displayed in the information area of the Logic Matrix properties.</td>
<td>Text</td>
</tr>
<tr>
<td>• Description</td>
<td>Description of the Logic Matrix. The description is displayed in runtime in the standard view of the matrix faceplate.</td>
<td>Text with maximum 2000 characters</td>
</tr>
<tr>
<td>• Block comment</td>
<td>General comments for this specific Logic Matrix. The text is assigned to the Logic Matrix block in the CFC as block comment.</td>
<td>Text with maximum 80 characters</td>
</tr>
<tr>
<td>Generation settings</td>
<td>Not all of the properties of this group can be imported</td>
<td>-</td>
</tr>
<tr>
<td>Operation permission settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cause</td>
<td>In the following cells, you can adapt the operator authorization levels for all causes. You can activate the enabled operations with the &quot;Enable&quot; cell. You specify the authorization level with the &quot;Level&quot; cell. Refer to the section &quot;Authorization OS&quot; tab (Page 50)&quot; for a description of the operator authorization levels.</td>
<td>-</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Possible input</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reset</td>
<td>Operator authorization level with which the operator can reset a cause.</td>
<td>• Enable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>Bypass</td>
<td>Operator authorization level with which the operator can set the bypass for a cause.</td>
<td>• Enable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>Bypass tag</td>
<td>Operator authorization level with which the operator can set the bypass for an input tag.</td>
<td>• Enable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>Reset first out group</td>
<td>Operator authorization level with which the operator can reset an active &quot;First Alarm Out&quot; selection for a cause.</td>
<td>• Enable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>Delay time</td>
<td>Operator authorization level with which the operator can change the delay time for an input tag.</td>
<td>• Enable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>Deviation limit</td>
<td>Operator authorization level with which the operator can change the value for the deviation limit of a cause.</td>
<td>• Enable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>Deviation hysteresis</td>
<td>Operator authorization level with which the operator can change the hysteresis for the deviation limit for a cause.</td>
<td>• Enable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>Simulation on</td>
<td>Operator authorization level with which the operator can activate the simulation for an input tag.</td>
<td>• Enable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Level: Numerical value 1-5</td>
</tr>
</tbody>
</table>
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Simulation</td>
<td>Operator authorization level with which the operator can change the simulation value for an input tag.</td>
<td>● Enable</td>
</tr>
<tr>
<td>value</td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td>– Level</td>
<td></td>
<td>● Level: Numerical value 1-5</td>
</tr>
<tr>
<td>● Flutter time</td>
<td>Operator authorization level with which the operator can change the flutter suppression time for a digital input tag.</td>
<td>● Enable</td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td>– Level</td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td>● Alarm limit</td>
<td>Operator authorization level with which the operator can change the alarm limit for analog input tags.</td>
<td>● Enable</td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td>– Level</td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td>● Warning limit</td>
<td>Operator authorization level with which the operator can change the warning limit for analog input tags.</td>
<td>● Enable</td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td>– Level</td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td>● Limit hysteresis</td>
<td>Operator authorization level with which the operator can change the hysteresis for the limits of an analog input tag.</td>
<td>● Enable</td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td>– Level</td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td>● Gradient up</td>
<td>Operator authorization level with which the operator can change the high gradient limit for an analog input tag.</td>
<td>● Enable</td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td>– Level</td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td>● Gradient down</td>
<td>Operator authorization level with which the operator can change the low gradient limit for an analog input tag.</td>
<td>● Enable</td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td>– Level</td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td>● Gradient hysteresis</td>
<td>Operator authorization level with which the operator can change the hysteresis for the gradients of an analog input tag.</td>
<td>● Enable</td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
<td>– True</td>
</tr>
<tr>
<td>– Level</td>
<td></td>
<td>– False</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Level: Numerical value 1-5</td>
</tr>
</tbody>
</table>
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
</table>
| Gradient reset | Operator authorization level with which the operator can reset the gradient values for an analog input tag. | • Enable  
|                | - Enabled                                                                   | - True  
|                | - Level                                                                     | - False  
|                |                                                                          | • Level: Numerical value 1-5  |
| Gradient lag time | Operator authorization level with which the operator can change the delay time for the gradient of an analog input tag. | • Enable  
|                  | - Enabled                                                                    | - True  
|                  | - Level                                                                      | - False  
|                  |                                                                          | • Level: Numerical value 1-5  |
| Deadband       | Operator authorization level with which the operator can change the deadband for an analog input tag. | • Enable  
|                | - Enabled                                                                    | - True  
|                | - Level                                                                      | - False  
|                |                                                                          | • Level: Numerical value 1-5  |
| Matrix         | In the following cells, you can adapt the operator authorization levels for the matrix.  
|                | You can activate the enabled operations with the "Enable" cell.  
|                | You specify the authorization level with the "Level" cell.  
|                | Refer to the section "Authorization OS" tab (Page 50)" for a description of the operator authorization levels. | -  |
| Reset visible causes | Operator authorization level with which the operator can reset all visible causes. | • Enable  
|                  | - Enabled                                                                   | - True  
|                  | - Level                                                                     | - False  
|                  |                                                                          | • Level: Numerical value 1-5  |
| Reset visible effects | Operator authorization level with which the operator can reset all visible effects. | • Enable  
|                    | - Enabled                                                                   | - True  
|                    | - Level                                                                     | - False  
|                    |                                                                          | • Level: Numerical value 1-5  |
| Effect         | In the following cells, you can adapt the central operator authorization levels for all effects.  
|                | You can activate the enabled operations with the "Enable" cell.  
|                | You specify the authorization level with the "Level" cell.  
|                | Refer to the section "Authorization OS" tab (Page 50)" for a description of the operator authorization levels. | -  |
| Reset          | Operator authorization level with which the operator can reset the cause.    | • Enable  
|                | - Enabled                                                                    | - True  
|                | - Level                                                                     | - False  
|                |                                                                          | • Level: Numerical value 1-5  |
### Configuring

#### 5.8 Exporting/importing a Logic Matrix file

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bypass</td>
<td>Operator authorization level with which the operator can set the bypass for the effect.</td>
<td>Enable – True, False, Level: Numerical value 1-5</td>
</tr>
<tr>
<td>Override</td>
<td>Operator authorization level with which the operator can set the override for the effect.</td>
<td>Enable – True, False, Level: Numerical value 1-5</td>
</tr>
<tr>
<td>Override time</td>
<td>Operator authorization level with which the operator can change the override time for the effect.</td>
<td>Enable – True, False, Level: Numerical value 1-5</td>
</tr>
<tr>
<td>Ovr.Prewarning time</td>
<td>Operator authorization level with which the operator can change the pre-warning time for the override for this effect.</td>
<td>Enable – True, False, Level: Numerical value 1-5</td>
</tr>
<tr>
<td>Delay time</td>
<td>Operator authorization level with which the operator can change the delay time for this effect.</td>
<td>Enable – True, False, Level: Numerical value 1-5</td>
</tr>
</tbody>
</table>

**Alarm settings**

<table>
<thead>
<tr>
<th>Cause</th>
<th>In the following cells, you can make the settings for the alarm and interrupt behavior of causes. Refer to the &quot;Alarms tab&quot; heading in the &quot;Auto-Hotspot&quot; (Page 50) section for a description of the alarm settings.</th>
<th>-</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messages</td>
<td>In this field, you specify if messages are to be generated for causes.</td>
<td>True, False</td>
</tr>
<tr>
<td>Message state actualization</td>
<td>In this field, you specify if the function of the Feature.Bit 22 of the APL is to be activated for the causes. You can find more information on the function of this I/O in the Advanced Process Library manual.</td>
<td>True, False</td>
</tr>
<tr>
<td>Active</td>
<td>In this field, you specify if cause blocks are to signal when the cause is active.</td>
<td>True, False</td>
</tr>
<tr>
<td>Limit / discrepancy / gradient active</td>
<td>In this field, you specify if cause blocks are to signal when the warning limit of an analog value has been violated.</td>
<td>True, False</td>
</tr>
<tr>
<td>Bypass active</td>
<td>In this field, you specify if cause blocks are to signal when the bypass is active.</td>
<td>True, False</td>
</tr>
</tbody>
</table>
### Property

<table>
<thead>
<tr>
<th>Property Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledge request</td>
<td>True, False</td>
</tr>
<tr>
<td>First out group active</td>
<td>True, False</td>
</tr>
<tr>
<td>Tag active</td>
<td>True, False</td>
</tr>
<tr>
<td>Tag simulated</td>
<td>True, False</td>
</tr>
<tr>
<td>Tag faulty (QC)</td>
<td>True, False</td>
</tr>
<tr>
<td>Matrix</td>
<td>-</td>
</tr>
<tr>
<td>Messages</td>
<td>True, False</td>
</tr>
<tr>
<td>Message state actualization</td>
<td>True, False</td>
</tr>
<tr>
<td>Degraded voting active</td>
<td>True, False</td>
</tr>
<tr>
<td>Cause active</td>
<td>True, False</td>
</tr>
<tr>
<td>Cause warning active</td>
<td>True, False</td>
</tr>
<tr>
<td>Cause bypass active</td>
<td>True, False</td>
</tr>
<tr>
<td>Effect active</td>
<td>True, False</td>
</tr>
<tr>
<td>Effect warning active</td>
<td>True, False</td>
</tr>
<tr>
<td>Effect bypass active</td>
<td>True, False</td>
</tr>
<tr>
<td>Effect</td>
<td>-</td>
</tr>
<tr>
<td>Messages</td>
<td>True, False</td>
</tr>
</tbody>
</table>

### Matrix

In the following cells, you can make the settings for the alarm and interrupt behavior of the matrix. Refer to the "Alarms tab" heading in the "Auto-Hotspot" section for a description of the alarm settings.
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message state actualization</td>
<td>In this field, you specify if the function of the Feature.Bit 22 of the APL is to be activated for the effects. You can find more information on the function of this I/O in the Advanced Process Library manual.</td>
<td>True, False</td>
</tr>
<tr>
<td>Active</td>
<td>In this field, you specify if an effect block is to signal when an effect is active.</td>
<td>True, False</td>
</tr>
<tr>
<td>Pre-alarm override active</td>
<td>In this field, you specify if an effect block is to signal when the pre-warning time for an override is active.</td>
<td>True, False</td>
</tr>
<tr>
<td>Bypass / override active</td>
<td>In this field, you specify if an effect block is to signal when the bypass/override is active.</td>
<td>True, False</td>
</tr>
<tr>
<td>Override error</td>
<td>In this field, you specify if an effect block is to signal when an override for an error has occurred.</td>
<td>True, False</td>
</tr>
<tr>
<td>Acknowledge request</td>
<td>In this field, you specify if an effect block is to signal when a reset is required.</td>
<td>True, False</td>
</tr>
<tr>
<td>View settings</td>
<td>In the following cells, you can adapt the representation of faceplate. The corresponding columns and rows with the information on the causes and effects are shown or hidden depending on the configuration.</td>
<td>-</td>
</tr>
</tbody>
</table>

#### Cause columns

The following information can be displayed or hidden for the cause:

- Link
- Value
- Alarm limit
- Unit
- Group
- First out group
- Comment

#### Effect rows

The following information can be displayed or hidden for the effect:

- Link
- Group
- Comment

### Note

The generation settings are not taken into account when importing and cannot be changed by an import.
"Version_History" worksheet

The "Version_History" worksheet contains all entries of the change management in tabular form if change management has been activated in the Logic Matrix Editor under "Edit -> Properties... -> Version".

**Note**
The data in the "Version_History" worksheet is for display and documentation only. Changes within this worksheet are ignored during import.

"Cause_Configuration" worksheet

The "Cause_Configuration" worksheet includes the information on all settings that can be assigned to a cause in the Logic Matrix Editor in the "Cause - Details" in the "Configuration" and "Operator authorizations" tab. The first three rows include information on which setting is entered in the respective column. The causes are defined starting in the fourth row.

**Note**
Unlike in the editor, here the number of the cause is specified manually by the configuration engineer in the first column. This number must be unique within the cause of a Logic Matrix because it is used for unique identification of the cause.

Information in the "Cause_Configuration" worksheet

<table>
<thead>
<tr>
<th>Column header</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Number</td>
<td>In this field, you enter a unique number for the cause.</td>
<td>Numerical value 0-124</td>
</tr>
<tr>
<td>Common</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Function</td>
<td>In this field, you enter the function type of the cause.</td>
<td>• AND, • OR or • XooY</td>
</tr>
<tr>
<td>• Group</td>
<td>In this field, you can assign a value as a filter criterion for the different causes of the Logic Matrix. This means you can sort multiple causes into groups.</td>
<td>Numerical value 0-31</td>
</tr>
<tr>
<td>• First out</td>
<td>In this field, you can assign the cause to a initial value group.</td>
<td>Numerical value 0-31</td>
</tr>
<tr>
<td>Voting</td>
<td>You can find a description of the functions in the section &quot;Cause (Page 16)&quot;.</td>
<td></td>
</tr>
<tr>
<td>• Quality</td>
<td>When this option is enabled, a value with bad signal status is considered bad.</td>
<td>• True • False</td>
</tr>
<tr>
<td>• Degr.</td>
<td>Enable the &quot;Degraded Voting&quot; function.</td>
<td>• True • False</td>
</tr>
<tr>
<td>Bypass</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Bypass tag</td>
<td>The specified tag activates the bypass function of the cause.</td>
<td>Tag name</td>
</tr>
<tr>
<td>Column header</td>
<td>Description</td>
<td>Possible input</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Timer</td>
<td>See section &quot;Timing (Page 21)&quot; for an illustration of the different modes.</td>
<td>Mode as text:</td>
</tr>
<tr>
<td></td>
<td>● Mode</td>
<td>No delay:</td>
</tr>
<tr>
<td></td>
<td>You set the time response of the cause in this area.</td>
<td>• No delay</td>
</tr>
<tr>
<td></td>
<td>● No delay</td>
<td>No time response set.</td>
</tr>
<tr>
<td></td>
<td>● On delay</td>
<td>Cause with on delay: The cause function must be fulfilled for the time configured in the &quot;Time:&quot; field until the cause becomes bad.</td>
</tr>
<tr>
<td></td>
<td>● Off delay</td>
<td>Cause with off delay: The cause does not become good until the cause function is not fulfilled for the time configured in the &quot;Time:&quot; field.</td>
</tr>
<tr>
<td></td>
<td>● Timed</td>
<td>Timed cause:</td>
</tr>
<tr>
<td></td>
<td>Time [s]</td>
<td>Time specified for time response in seconds.</td>
</tr>
<tr>
<td>Deviation</td>
<td>You can find a description of the functions in the section &quot;Analog input deviation (Page 18)&quot;.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Enabled</td>
<td>In this area, you can enable the response of the cause for analog values with the &quot;Deviation&quot; function.</td>
</tr>
<tr>
<td></td>
<td>● Limit</td>
<td>In this field, you enter the limit of the deviation.</td>
</tr>
<tr>
<td></td>
<td>● Hyst.</td>
<td>In this field, you enter a hysteresis for the limit of the deviation.</td>
</tr>
<tr>
<td>Alarms</td>
<td>Possible settings for message and alarm response of the block. Refer to the &quot;&quot;Alarms&quot; tab&quot; heading in the &quot;&quot;Properties&quot;&quot; dialog box of the Logic Matrix (Page 50)&quot; section for a description of the alarm settings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Use Mx settings</td>
<td>When this option is disabled (cell content &quot;False&quot;), a custom message response can be made for the cause independent of the matrix settings. The setting in the next cells applies in this case.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If this setting is &quot;True&quot;, the following settings of the alarms are not imported.</td>
</tr>
<tr>
<td></td>
<td>● Msg enabled</td>
<td>In this field, you specify if messages are to be generated for this cause. This setting is only imported if &quot;Use Mx Settings&quot; for alarms is &quot;False&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Cause active</td>
<td>In this field, you specify if the cause block is to signal when the cause is active. This setting is only imported if &quot;Use Mx Settings&quot; for alarms is &quot;False&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Limit active</td>
<td>In this field, you specify if the cause block is to signal when the warning limit of an analog value has been violated. This setting is only imported if &quot;Use Mx Settings&quot; for alarms is &quot;False&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column header</td>
<td>Description</td>
<td>Possible input</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Bypass active</td>
<td>In this field, you specify if the cause block is to signal when the bypass is active. This setting is only imported if &quot;Use Mx Settings&quot; for alarms is &quot;False&quot;.</td>
<td>True • False</td>
</tr>
<tr>
<td>Ackn. Req.</td>
<td>In this field, you specify if the cause block is to signal when a reset is required. This setting is only imported if &quot;Use Mx Settings&quot; for alarms is &quot;False&quot;.</td>
<td>True • False</td>
</tr>
<tr>
<td>First alarm</td>
<td>In this field, you specify if the cause block is to signal when it has the &quot;First Out Alarm Group&quot; pointer. This setting is only imported if &quot;Use Mx Settings&quot; for alarms is &quot;False&quot;.</td>
<td>True • False</td>
</tr>
<tr>
<td>Tag active</td>
<td>In this field, you specify if the cause block is to signal when a digital value is active. This setting is only imported if &quot;Use Mx Settings&quot; for alarms is &quot;False&quot;.</td>
<td>True • False</td>
</tr>
<tr>
<td>Sim. active</td>
<td>In this field, you specify if the cause block is to signal when an input value is in simulation. This setting is only imported if &quot;Use Mx Settings&quot; for alarms is &quot;False&quot;.</td>
<td>True • False</td>
</tr>
<tr>
<td>Tag QC bad</td>
<td>In this field, you specify if the cause block is to signal when an input value returns a bad quality code. This setting is only imported if &quot;Use Mx Settings&quot; for alarms is &quot;False&quot;.</td>
<td>True • False</td>
</tr>
</tbody>
</table>

**Features**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit output</td>
<td>This setting only has an effect when monitoring of the deviation limit is enabled. If this option is active, the cause is triggered as soon as the configured deviation limit is exceeded.</td>
<td>True • False</td>
</tr>
<tr>
<td>Auto reset</td>
<td>If this option is selected, the cause is reset automatically when the trigger condition is no longer fulfilled.</td>
<td>True • False</td>
</tr>
<tr>
<td>1 tag sim</td>
<td>If this option is selected, only one input tag of the cause can be simulated at a time.</td>
<td>True • False</td>
</tr>
<tr>
<td>1 tag bypass</td>
<td>If this option is selected, only one input tag of the cause can be bypassed at a time.</td>
<td>True • False</td>
</tr>
</tbody>
</table>

**Operation**

You can adapt the operator authorization levels for this cause in the following cells. You can activate the enabled operations with the "Enable" cell. You specify the authorization level with the "Level" cell. Refer to the section "Authorization OS" tab (Page 50) for a description of the operator authorization levels.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Mx settings</td>
<td>When this option is disabled (cell content &quot;False&quot;), separate operator authorization levels can be made for the cause independent of the matrix settings. The setting in the next cells apply in this case. If this setting is &quot;True&quot;, the following settings of the operator authorizations are not imported.</td>
</tr>
<tr>
<td>Column header</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Reset</td>
<td>Operator authorization level with which the operator can reset the cause.</td>
</tr>
<tr>
<td></td>
<td>The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations is &quot;False&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
</tr>
<tr>
<td>– Level</td>
<td></td>
</tr>
<tr>
<td>• Bypass</td>
<td>Operator authorization level with which the operator can set the bypass for this cause.</td>
</tr>
<tr>
<td></td>
<td>The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations is &quot;False&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
</tr>
<tr>
<td>– Level</td>
<td></td>
</tr>
<tr>
<td>• Reset alarm grp</td>
<td>Operator authorization level with which the operator can reset an active &quot;First Alarm Out&quot; selection for the cause.</td>
</tr>
<tr>
<td></td>
<td>The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations is &quot;False&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
</tr>
<tr>
<td>– Level</td>
<td></td>
</tr>
<tr>
<td>• Cause time</td>
<td>Operator authorization level with which the operator can change the delay time for the analog input tag.</td>
</tr>
<tr>
<td></td>
<td>The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations is &quot;False&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
</tr>
<tr>
<td>– Level</td>
<td></td>
</tr>
<tr>
<td>• Deviation limit</td>
<td>Operator authorization level with which the operator can change the deviation limit for the cause.</td>
</tr>
<tr>
<td></td>
<td>The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations is &quot;False&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
</tr>
<tr>
<td>– Level</td>
<td></td>
</tr>
<tr>
<td>• Deviation hys.</td>
<td>Operator authorization level with which the operator can change the hysteresis for the deviation limit for a cause.</td>
</tr>
<tr>
<td></td>
<td>The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations is &quot;False&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>– Enabled</td>
<td></td>
</tr>
<tr>
<td>– Level</td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>You can specify a comment in this cell that is displayed in the faceplate for this cause.</td>
</tr>
</tbody>
</table>

Comment:
You can specify a comment in this cell that is displayed in the faceplate for this cause.
"Cause_Analog_Inputs" worksheet

The "Cause_Analog_Inputs" worksheet includes the information about which input tag with a certain link can be assigned to a specific cause as well as all settings that can be assigned to an analog input tag in the Logic Matrix Editor in the "Cause - Details" in the "Analog parameters" and "Operator authorizations" tab. The first three rows include information on which setting is entered in the respective column. The analog input tags are defined starting in the fourth row.

Note

Unlike in the editor, here the unique number of the cause to which this analog input tag is to be assigned is specified manually by the configuration engineer in the first column. The configuration engineer must ensure that no more than three analog input tags are assigned to a cause.

Information in the "Cause_Analog_Inputs" worksheet

<table>
<thead>
<tr>
<th>Column header</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Number</td>
<td>In this field, you enter specify the number of the cause to which this analog input tag is to be assigned.</td>
<td>Numerical value 0-124</td>
</tr>
<tr>
<td>Input tag</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| • Tag           | In this field, enter the tag that is to return the signal. The signal can be provided through a direct connection, an internal direct connection or a standard link. The type of signal is set by the format of the input. | • "Chart\Block.IO" → Direct connection  
                  • "Cause.IO"/ "Effect.IO" → Internal direct connection  
                  • "Chart" → Standard link                                      |
<p>| • Link          | In this field, you enter the name of the link on the basis of which the interconnection is to take place. The setting is only imported when the tag is a standard link. Because a direct connection has no link, the content of this cell is not imported when the tag is a direct connection or an internal direct connection. | Text                                |
| • OS Disp.      | In this field, enter the name to be displayed for the link in Runtime. The setting is only imported when the tag is a direct connection or an internal direct connection. The displayed name for a standard link is set in the Link-Editor, which means the content of this cell is not imported when the tag is a standard link. | Text                                |
| Operation scale |                                                                             |                                      |
| • High          | In this field, you enter the high OS display range for the value.            | Numerical value, decimal point (.)    |
| • Low           | In this field, you enter the low OS display range for the value.             | Numerical value, decimal point (.)    |</p>
<table>
<thead>
<tr>
<th>Column header</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>In this field, you enter the unit of the analog value as text. The entered text is used for the display in the Logic Matrix.</td>
<td>Characters for the unit. (e.g. mA, %, °C)</td>
</tr>
<tr>
<td>Format</td>
<td>In this field, you specify how the analog value is displayed in the matrix.</td>
<td>The display is based on the format instruction for user-defined number format character strings in C#. A 0 is a 0 placeholder: If the place exists in the value, the value is displayed; if not, a 0 is displayed. A # is a number placeholder. If there is a numeral at this place in the value, the value is displayed; if not, nothing is displayed. A '.' is the decimal separator; a ',' is a thousands separator.</td>
</tr>
<tr>
<td>Deadb.</td>
<td>In this field, you enter the deadband. The deadband suppresses values hovering around the zero point.</td>
<td>Numerical value, decimal point (.)</td>
</tr>
</tbody>
</table>
| Limit         | In this field, you specify if the limits are high or low limits. | High: H  
Low: L |
|               | • Type       | In this field, you specify if the limits are high or low limits.  
High (H): Input tag is enabled for: Value >= "Limit"  
Low (L): Input tag is enabled for: Value <= "Limit" |
|               | • Hyst.      | In this field, you enter a hysteresis for the limits. | Numerical value, decimal point (.) |
|               | • Alarm       | In the "Enable" cell, you specify if there is an alarm limit for the analog input tag. You enter the alarm limit in the "Limit" cell. | • Enable  
- True  
- False  
• Limit: Numerical value, decimal point (.) |
|               | • Warning     | In the "Enable" cell, you specify if there is a warning limit for the analog input tag. You enter the warning limit in the "Limit" cell. | • Enable  
- True  
- False  
• Limit: Numerical value, decimal point (.) |
| Gradient      | In the "Enable" cell, you specify if there is an alarm limit for the analog input tag. You enter the alarm limit in the "Limit" cell. | • Enable  
- True  
- False  
• Limit: Numerical value, decimal point (.) |
| Lag time [s]  | A P-T1 filter can be used to filter the process value prior to the formation of the gradient. The delay time specified here is the time constant of the filter. | Numerical value as integer |
| Time factor   | This cell is used to normalize the time factor for the gradient calculation by seconds, minutes and seconds. | SEC  
MIN  
HOUR |
<table>
<thead>
<tr>
<th>Column header</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hysteresis</td>
<td>In this field, you enter the hysteresis for the gradient.</td>
<td>Numerical value, decimal point (.)</td>
</tr>
</tbody>
</table>
| • Up         | In the "Enable" cell, you specify if there is a high gradient limit for the analog input tag. You enter the gradient limit in the "Limit" cell. | • Enable  
  – True  
  – False  
  • Limit: Numerical value, decimal point (.) |
|             |            |                |
| • Down       | In the "Enable" cell, you specify if there is a low gradient limit for the analog input tag. You enter the gradient limit in the "Limit" cell. | • Enable  
  – True  
  – False  
  • Limit: Numerical value, decimal point (.) |
|             |            |                |
| Operation    | You can adapt the operator authorization levels for this analog input tag in the following cells. You can activate the enabled operations with the "Enable" cell. You specify the authorization level with the "Level" cell. Refer to the section "Authorization OS" tab (Page 50) for a description of the operator authorization levels. The settings in the next cell are only in effect when the "Use Mx Settings" function is disabled for the associated cause. |                |
| • Alarm Limit| Operator authorization level with which the operator can change the alarm limit for the analog input tag. The setting is only imported when "Use Mx Settings" for operator authorizations of the corresponding cause is "False". | • Enable  
  – True  
  – False  
  • Level: Numerical value 1-5 |
|             |            |                |
| • Warning limit| Operator authorization level with which the operator can change the warning limit for the analog input tag. The setting is only imported when "Use Mx Settings" for operator authorizations of the corresponding cause is "False". | • Enable  
  – True  
  – False  
  • Level: Numerical value 1-5 |
|             |            |                |
| • Limit Hyst.| Operator authorization level with which the operator can change the hysteresis for the limits of the analog input tag. The setting is only imported when "Use Mx Settings" for operator authorizations of the corresponding cause is "False". | • Enable  
  – True  
  – False  
  • Level: Numerical value 1-5 |
|             |            |                |
| • Deadband   | Operator authorization level with which the operator can change the deadband for the analog input tag. The setting is only imported when "Use Mx Settings" for operator authorizations of the corresponding cause is "False". | • Enable  
  – True  
  – False  
  • Level: Numerical value 1-5 |
<table>
<thead>
<tr>
<th>Column header</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Gradient up limit</td>
<td>Operator authorization level with which the operator can change the high gradient limit for the analog input tag. The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations of the corresponding cause is &quot;False&quot;.</td>
<td>• Enable&lt;br&gt;– True&lt;br&gt;– False&lt;br&gt;• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>● Enabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Level</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Gradient down limit</td>
<td>Operator authorization level with which the operator can change the low gradient limit for the analog input tag. The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations of the corresponding cause is &quot;False&quot;.</td>
<td>• Enable&lt;br&gt;– True&lt;br&gt;– False&lt;br&gt;• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>● Enabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Level</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Gradient hysteresis</td>
<td>Operator authorization level with which the operator can change the hysteresis for the gradients of the analog input tag. The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations of the corresponding cause is &quot;False&quot;.</td>
<td>• Enable&lt;br&gt;– True&lt;br&gt;– False&lt;br&gt;• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>● Enabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Level</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Gradient reset</td>
<td>Operator authorization level with which the operator can reset the gradient values for the analog input tag. The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations of the corresponding cause is &quot;False&quot;.</td>
<td>• Enable&lt;br&gt;– True&lt;br&gt;– False&lt;br&gt;• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>● Enabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Level</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Gradient lag time</td>
<td>Operator authorization level with which the operator can change the delay time for the analog input tag. The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations of the corresponding cause is &quot;False&quot;.</td>
<td>• Enable&lt;br&gt;– True&lt;br&gt;– False&lt;br&gt;• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>● Enabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Level</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Sim on / off</td>
<td>Operator authorization level with which the operator can activate the simulation for the analog input tag. The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations of the corresponding cause is &quot;False&quot;.</td>
<td>• Enable&lt;br&gt;– True&lt;br&gt;– False&lt;br&gt;• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>● Enabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Level</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Simulated value</td>
<td>Operator authorization level with which the operator can change the simulation value for the analog input tag. The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations of the corresponding cause is &quot;False&quot;.</td>
<td>• Enable&lt;br&gt;– True&lt;br&gt;– False&lt;br&gt;• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>● Enabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Level</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Bypass tag</td>
<td>Operator authorization level with which the operator can set the bypass for the analog input tag. The setting is only imported when &quot;Use Mx Settings&quot; for operator authorizations of the corresponding cause is &quot;False&quot;.</td>
<td>• Enable&lt;br&gt;– True&lt;br&gt;– False&lt;br&gt;• Level: Numerical value 1-5</td>
</tr>
<tr>
<td>● Enabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Level</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
"Cause_Digital_Inputs" worksheet

The "Cause_Digital_Inputs" worksheet includes the information about which input tag with a certain link can be assigned to a specific cause as well as all settings that can be assigned to a digital input tag in the Logic Matrix Editor in the "Cause - Details" in the "Digital parameters" and "Operator authorizations" tab. The first three rows include information on which setting is entered in the respective column. The analog input tags are defined starting in the fourth row.

**Note**

Unlike in the editor, here the unique number of the cause to which this digital input tag is to be assigned is specified manually by the configuration engineer in the first column. The configuration engineer must ensure that no more than three digital input tags are assigned to a cause.

**Information in the "Cause_Digital_Inputs" worksheet**

<table>
<thead>
<tr>
<th>Column header</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cause</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Number</strong></td>
<td>In this field, you enter specify the number of the cause to which this digital input tag is to be assigned.</td>
</tr>
<tr>
<td><strong>Input tag</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Tag</strong></td>
<td>In this field, enter the tag that is to return the signal. The signal can be provided through a direct connection, an internal direct connection or a standard link. The type of signal is set by the format of the input.</td>
</tr>
<tr>
<td></td>
<td><strong>Link</strong></td>
<td>In this field, you enter the name of the link on the basis of which the interconnection is to take place. The setting is only imported when the tag is a standard link. Because a direct connection has no link, the content of this cell is not imported when the tag is a direct connection or an internal direct connection.</td>
</tr>
<tr>
<td></td>
<td><strong>OS Disp.</strong></td>
<td>In this field, enter the name to be displayed for the link in Runtime. The setting is only imported when the tag is a direct connection or an internal direct connection. The displayed name for a standard link is set in the Link-Editor, which means the content of this cell is not imported when the tag is a standard link.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>In this area, you specify the trigger type of the value:</td>
<td>● ETT \n● DTT</td>
</tr>
<tr>
<td></td>
<td>● 1 enabled (ETT): The input tag is enabled when the input signal is &quot;true&quot;.</td>
<td>● 0 enabled (DTT): The input tag is enabled when the input signal is &quot;false&quot;.</td>
</tr>
</tbody>
</table>
### Column header | Description | Possible input
---|---|---
Enabled | In this area, you can enable the flutter suppression for the digital value. | ● True  
● False

Time [s] | The value entered in this field is the time for the flutter suppression. The input tag must be enabled or disabled for at least the specified time with activated flutter suppression so that the value change is applied to the cause. | Numerical value as integer

Operation | You can adapt the operator authorization levels for this cause in the following cells. You can activate the enabled operations with the "Enable" cell. You specify the authorization level with the "Level" cell. Refer to the section "Authorization OS" tab (Page 50) for a description of the operator authorization levels. The settings in the next cell are only in effect when the "Use Mx Settings" function is disabled for the associated cause. | ● Enable  
– True  
– False  
● Level: Numerical value 1-5

- **Flutter time**  
  - Enabled  
  - Level

- **Sim on / off**  
  - Enabled  
  - Level

- **Simulated value**  
  - Enabled  
  - Level

- **Bypass tag**  
  - Enabled  
  - Level

"Intersections" worksheet

The "Intersections" worksheet includes a matrix in form of a table. In the worksheet, you define the function at the intersections of the numbered causes and effects with which the respective cause has an effect on the effect. The identifier of function of an intersection is also assigned in the Logic Matrix Editor:

- **N** - Not stored
- **S** - Stored
- **V** - Overridable
• R - Resettable and overridable
• XooY - Multi-nodes

"Effect_Configuration" worksheet:

The "Effect_Configuration" worksheet includes the information on all settings that can be assigned to an effect in the Logic Matrix Editor in the "Effect - Details" in the "Configuration" and "Operator authorizations" tab. The first three rows include information on which setting is entered in the respective column. The effects are defined starting in the fourth row.

Note

Unlike in the editor, here the number of the effect is specified manually by the configuration engineer in the first column. This number must be unique within the effect of a Logic Matrix because it is used for unique identification of the effect.

Information in the "Effect_Configuration" worksheet

<table>
<thead>
<tr>
<th>Column header</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effect</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Number</td>
<td>In this field, you enter a unique number for the effect.</td>
<td>Numerical value 0-124</td>
</tr>
<tr>
<td>Common</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Group</td>
<td>In this field, you can assign a value as a filter criterion for the different causes of the Logic Matrix. This means you can sort multiple causes into groups.</td>
<td>Numerical value 0-31</td>
</tr>
<tr>
<td>• Mode</td>
<td>In this field, you specify the tripping type of the effect: ● 0 enabled (DTT) ● 1 enabled (ETT) The description of the tripping types can be found in section Definitions (Page 12).</td>
<td>● DTT ● ETT</td>
</tr>
<tr>
<td>Reset</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Tag</td>
<td>The specified tag resets the effect.</td>
<td>Tag name</td>
</tr>
<tr>
<td>Bypass</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Tag</td>
<td>The specified tag activates the bypass function of the effect.</td>
<td>Tag name</td>
</tr>
<tr>
<td>Override</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Tag</td>
<td>The specified tag activates the override function of the effect.</td>
<td>Tag name</td>
</tr>
<tr>
<td>• Time [s]</td>
<td>Setting for the time that the override function is to overwrite the effect.</td>
<td>Numerical value as integer</td>
</tr>
<tr>
<td>• Prewarn. Time</td>
<td>Setting for the pre-warning time of the message before override is revoked.</td>
<td>Numerical value as integer</td>
</tr>
<tr>
<td>Timer</td>
<td>See section &quot;Time response (Page 21)&quot; for an illustration of the different modes.</td>
<td></td>
</tr>
</tbody>
</table>
### Column header | Description | Possible input
---|---|---
• **Mode** | You set the time response of the cause in this area. | Mode as text:
  • **No delay**
    No time response set.
  • **On delay**
    Cause with on delay: The cause function must be fulfilled for the time configured in the "Time:" field until the cause becomes bad.
  • **Off delay**
    Cause with off delay: The cause does not become good until the cause function is not fulfilled for the time configured in the "Time:" field.
  • **Timed**
    Timed cause:

• **Time [s]** | Time specified for time response in seconds. | Numerical value as integer

### Alarms
Possible settings for message and alarm response of the block. Refer to the "Alarms" tab heading in the "Properties" dialog box of the Logic Matrix (Page 50) section for a description of the alarm settings.

• **Use Mx settings** | When this option is disabled (cell content "False"), a custom message response can be made for the effect independent of the matrix settings. The setting in the next cells applies in this case. If this setting is "True", the following settings of the alarms are not imported. | • True
  • False

• **Msg enabled** | In this field, you specify if messages are to be generated for this effect. This setting is only imported if "Use Mx Settings" for alarms is "False". | • True
  • False

• **Effect active** | In this field, you specify if the effect block is to signal when the effect is active. This setting is only imported if "Use Mx Settings" for alarms is "False". | • True
  • False

• **Override prewarn.** | In this field, you specify if the effect block is to signal when the pre-warning time for an override is active. This setting is only imported if "Use Mx Settings" for alarms is "False". | • True
  • False

• **Bypass / Override active** | In this field, you specify if the effect block is to signal when the bypass / override is active. This setting is only imported if "Use Mx Settings" for alarms is "False". | • True
  • False

• **Override error** | In this field, you specify if the effect block is to signal when an override error has occurred. This setting is only imported if "Use Mx Settings" for alarms is "False". | • True
  • False

• **Ackn. Req.** | In this field, you specify if the effect block is to signal when a reset is required. This setting is only imported if "Use Mx Settings" for alarms is "False". | • True
  • False
<table>
<thead>
<tr>
<th>Column header</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation</td>
<td>In the following cells, you can adapt the operator authorization levels for this effect. You can activate the enabled operations with the &quot;Enable&quot; cell. You specify the authorization level with the &quot;Level&quot; cell. Refer to the section &quot;Authorization OS&quot; tab (Page 50) for a description of the operator authorization levels.</td>
<td></td>
</tr>
</tbody>
</table>
| Use Mx settings | When this option is disabled (cell content "False"), separate operator authorization levels can be made for the effect independent of the matrix settings. The setting in the next cells apply in this case. If this setting is "True", the following settings of the operator authorizations are not imported. | • True  
• False |
| Reset         | Operator authorization level with which the operator can reset the cause. The setting is only imported when "Use Mx Settings" for operator authorizations is "False". | • Enable  
  - True  
  - False  
  - Level: Numerical value 1-5 |
| Bypass        | Operator authorization level with which the operator can set the bypass for the effect. The setting is only imported when "Use Mx Settings" for operator authorizations is "False". | • Enable  
  - True  
  - False  
  - Level: Numerical value 1-5 |
| Override      | Operator authorization level with which the operator can set the override for the effect. The setting is only imported when "Use Mx Settings" for operator authorizations is "False". | • Enable  
  - True  
  - False  
  - Level: Numerical value 1-5 |
| Override time | Operator authorization level with which the operator can change the override time for the effect. The setting is only imported when "Use Mx Settings" for operator authorizations is "False". | • Enable  
  - True  
  - False  
  - Level: Numerical value 1-5 |
| Ovr.Prewarning time | Operator authorization level with which the operator can change the pre-warning time for the override for this effect. The setting is only imported when "Use Mx Settings" for operator authorizations is "False". | • Enable  
  - True  
  - False  
  - Level: Numerical value 1-5 |
| Delay time    | Operator authorization level with which the operator can change the delay time for this effect. The setting is only imported when "Use Mx Settings" for operator authorizations is "False". | • Enable  
  - True  
  - False  
  - Level: Numerical value 1-5 |
| Comment       | You can specify a comment in this cell that is displayed in the faceplate for this effect. | Text with up to 64 characters |
"Effect_Outputs" worksheet

The "Effect_Outputs" worksheet includes information on which output tag is assigned to a specific effect with which link.

The first three rows include information on which setting is entered in the respective column. The analog input tags are defined starting in the fourth row.

Unlike in the editor, here the unique number of the effect to which this output tag is to be assigned is specified manually by the configuration engineer in the first column.

**Information in the "Effect_Outputs" worksheet**

<table>
<thead>
<tr>
<th>Column header</th>
<th>Description</th>
<th>Possible input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effect</td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Number</td>
<td>In this field, you enter the number of the effect to which this output tag is to be assigned.</td>
<td>Numerical value 0-124</td>
</tr>
<tr>
<td>Output tag</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| ● Tag         | In this field, enter the tag that is the destination of the signal. The signal can be provided through a direct connection, an internal direct connection or a standard link. The type of signal is set by the format of the input. | ● "Chart\Block.IO" → Direct connection  
    ● "Cause.IO"/"Effect.IO" → Internal direct connection  
    ● "Chart" → Standard link |
| ● Link        | In this field, you enter the name of the link on the basis of which the interconnection is to take place. The setting is only imported when the tag is a standard link. Because a direct connection has no link, the content of this cell is not imported when the tag is a direct connection or an internal direct connection. | Text |
| ● OS Disp.    | In this field, enter the name to be displayed for the link in Runtime. The setting is only imported when the tag is a direct connection or an internal direct connection. The displayed name for a standard link is set in the Link-Editor, which means the content of this cell is not imported when the tag is a standard link. | Text |

5.8.3 Importing a Logic Matrix file (.ods)

**Procedure**

To import an .ods file after external editing, follow these steps:

- In the Logic Matrix Editor, select the menu command **File > Importing...** and select the required .ods file.
The Logic Matrix Editor now applies the content of the .ods file to the open Logic Matrix.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>During import, the interlock logic of the Logic Matrix open in the editor is replaced with the content of the .ods file.</strong></td>
</tr>
<tr>
<td>As a result, all blocks in the CFC are replaced during the next generation (if a cause is deleted and recreated again, it obtains another ID, which means the corresponding block is deleted with the generation and a new one is created). Any manual adaptations to the CFC are lost.</td>
</tr>
</tbody>
</table>

**Result**

The imported Logic Matrix appears in the *Logic Matrix Editor* and can now be processed further, transferred, compiled and downloaded. If the import file includes information that cannot be assigned during the import, the user is informed about this situation.
5.8 Exporting/importing a Logic Matrix file
The transfer of a Logic Matrix to the project includes

- Saving the Logic Matrix including checking the configuration for validity.
- Generating the matrix CFC with blocks from the Logic Matrix block library.
- Generating the OS description file and copying the file to the corresponding OS project.

**Note**

**Changes in the project**

If new CFCs are added to the project or if existing CFCs are deleted and these CFCs had or will have connections to or from the matrix, it may be necessary to import the charts prior to the transfer.

Because the transfer only transfers the data from the Logic Matrix Editor to the Simatic Manager project, the user must subsequently distribute all changes to the respective stations. This means that affected stations (AS/OS) must be compiled and loaded after transfer from the Logic Matrix Editor to the Simatic Manager.

### 6.1 Transferring the Logic Matrix to the project

After complete configuration of a Logic Matrix, it must be saved and transferred to the project before the charts are compiled and downloaded to the CPU for execution.

**Transferring the Logic Matrix in a project**

1. Select the menu command Generate > Generate CFC.
2. The "Generation Matrix" window opens.
3. Check the settings for "Hierarchy", "Number of startup cycles", "Cycle time" "OS block icons" and "Intersection DB".
4. You can use the "Read back CFC" button to read back changes made to an existing Matrix CFC. You can delete an existing CFC before generating with the "Delete CFC" button.
5. Start the generation with the "OK" button. The generator creates the Matrix CFC as well as the OS description file in the project.

Perform steps 1 to 5 for each Logic Matrix to be transferred.
If causes or effects have been added or deleted, the OS must be compiled

**Note**
A runtime group is automatically created for the Logic Matrix during the transfer. This runtime group is installed in the OB that was selected in the properties of the Logic Matrix.

**NOTICE**
**Intersection DB**
Keep in mind that the DB number for the Intersection DB must be located in the user area of the DB. If this is not the case, parts of the PCS7 program (e.g. instance DBs) can be overwritten by the generator.

**See also**
Overview for configuring messages (Page 48)

## 6.2 Compiling and downloading to the CPU

### Requirement
All Logic Matrices of the S7 program to be compiled have already been successfully transferred.

### Compiling the SIMATIC-Project
1. Make sure that all Logic matrices of the controller have already been completely transferred.
2. Select the **Options > CFC > Compile** menu command.
3. Once the project has been successfully compiled, the program can be downloaded to the CPU.

### Downloading the SIMATIC project to the CPU
1. Select the **Options > CPU > Download** menu command.

**Note**
**Download changes to CPU - "Include user data blocks" setting**
If the "Changes" download mode is selected for loading the CPU, the user data blocks need to be included in the download to ensure correct functioning of Logic Matrix.

The Logic Matrix can now be checked for proper functioning.

If changes were made to the logic matrices that have an effect on the user interface (adding or deleting causes, changing OS texts), the OS must be compiled and downloaded for these changes to take effect on the operator stations.
6.3 Compiling and downloading to the Operator Station

Requirements

All S7 programs that are assigned to the OS have already been compiled.

Configuration and data storage

Configuring is performed exclusively in the ES in PCS 7 and then downloaded to the OS server. All configuration data are managed centrally and stored in the PCS 7 project. Project data, such as pictures, tags, and archives, are stored on the OS server and made available for the OS clients.

Note

Before the compilation and download to the OS, the CFC of the Logic Matrix in the plant hierarchy (PH) generated during transfer of the Logic Matrix must be assigned to the desired hierarchy folder.

Compiling and downloading to the OS

A project is downloaded using the central "Compile and download objects" function in SIMATIC Manager. Objects represented in the dialog box correspond to the component view in SIMATIC Manager, i.e., all SIMATIC PC stations that you created in SIMATIC Manager are displayed in this dialog box. In this central location, you make all necessary settings for compiling and downloading. In addition, you specify whether you want to compile and download the entire project or individual operator stations in this dialog box.

Note

Compiling an OS with activated WinCC runtime is not supported on a single ES/OS.

Transferring changes in a Logic Matrix

Changes in a Logic Matrix are not automatically transferred to the operator station. You can transfer the changes by compiling and downloading to the operator station.

Special circumstances when downloading in the case of single-user systems

If the OS and ES are operated on one computer, you do not have to perform any download operations because all necessary data are already present.

See also

Detailed information regarding "Compiling/downloading to an OS" can be found in the "Process Control System PCS 7; Operator Station" configuration manual. Additional information on this document is available in the preface.
See also

Installing (Page 37)
7.1 Overview of operator control and monitoring

Introduction

The "Operator control and monitoring" functionality of the Logic Matrix allows you to monitor and control the behavior of a Logic Matrix during operation. This occurs with the faceplates during runtime of a PCS 7 OS.

Requirements for operator control and monitoring

You perform operator control and monitoring on the Operator Station via the Logic Matrix faceplates.

The following requirements apply to operator control and monitoring of a Logic Matrix.

On the OS (Logic Matrix faceplates)

- The S7 program containing the Logic Matrix is compiled and downloaded to the CPU.
- The user(s) with the relevant permissions are set up.
- The configuration of the Logic Matrix faceplates is downloaded to the OS.

7.2 Expansion of the PCS 7 process tag browser

Introduction

General information on the function of the PCS 7 process tag browser is available in the PCS 7 - OS Process Control manual in the section Execution of system operations under "How to work with the "PCS 7 process tag browser" function.

Expanding the selection of the states

The Logic Matrix expands the PCS 7 process tag browser by four selection options for states:

- Image 7-1 Interlock through Logic Matrix active
- Image 7-2 Reset query through Logic Matrix
7.3 Block icon and faceplates

7.3.1 Structure of the user interface

Block icon and faceplates

The user interface of Logic Matrix consists of block icons of the matrix and a faceplate for each matrix, cause and effect blocks.

The faceplates for cause and effects are always opened via the matrix. The matrix faceplate can be opened using the block icon or using the APL function "Call-up of other faceplates". A call-up of the cause or effect faceplate using the "Call-up of other faceplates" function is forwarded to the matrix faceplate.

If the matrix faceplate is opened via the "Call additional faceplates" function, a filter is automatically set to display only information relevant to the call source.

Modular configuration of the cause faceplate

The representation of the cause faceplate is adapted depending on the configuration of the cause. The size of the faceplate varies depending on how many analog and digital input tags are configured for the cause. Fully expanded configuration is shown in the following sections.

7.3.2 Views of the blocks

Views of the LM_Matrix block

The LM_Matrix block has the following views:

- Standard view of LM_Matrix
- Message view
- Preview of LM_Matrix
- Memo view
Views of the LM_Cause block

The LM_Cause block has the following views:

- Standard view of LM_Cause
- Limit view of LM_Cause
- Trend view
- Parameter view of LM_Cause
- Preview of LM_Cause
- Memo view
- Batch view

You can find general information on the faceplate in the section *Structure of the faceplate* in the *APL Function Manual.*

Views of the LM_Effect block

The LM_Effect block has the following views:

- Standard view of LM_Effect
- Preview of LM_Effect
- Memo view

You can find general information on the faceplate in the section *Structure of the faceplate* in the *APL Function Manual.*

Extended status display
7.3.3 Standard view of the matrix block

Standard view of the matrix block

The standard view of the Logic Matrix block contains a dynamized mapping of the matrix created in the Logic Matrix Editor. Operator inputs for causes and effects can be made from this view. In addition, it is used to open the cause and effect faceplates and provides the option of jumping to the faceplates of the signal sources of the input and output tags.

Note

Displayed columns and rows

The figures below show the overall configuration of the standard view of the Logic Matrix. The settings in the SIMATIC Logic Matrix Editor under "Edit -> Settings... -> Display settings" enable a customized display of columns and rows in the faceplate.

Additional buttons and displays in the operator controls of the Logic Matrix

You can minimize the faceplate display of the matrix with the button. It is set to the size of the standard faceplate, at the most. If the matrix is smaller than the standard faceplate, it is adapted to the size of the matrix shown.

You can optimize the faceplate display of the matrix with the button. It is adapted to the size of the matrix shown. If the matrix is larger than the work area shown, the faceplate is set to the height or width of the work area, at most, and a scrollbar is displayed.

You can maximize the faceplate display of the matrix with the button. It is then displayed on the entire work area.

The display becomes visible when the data of the Logic Matrix are different in the automation system (AS) and the operator station (OS). This status comes about when new states are loaded only to the operator station or the automation system. The display also appears in the faceplates of the causes and effects associated with the matrix.
(1) **Open the faceplate of the causes and effects**

By clicking on the arrow icon, you can jump to the standard view of the block that supplies the signal for the input tag or the output tag.

(2) **Status display for initial value and delay time**

The status display shows whether a delay time (/gif) is enabled or an initial value signal (/gif) is detected at the cause.

The status display shows whether a delay time (/gif) is enabled at the effect.

(3) **Reset all visible causes / effect**

Use the [button] above the causes or effects to open the dialog for resetting the cause/effect. This button resets all visible causes or effects requiring reset at once.

If a filter is set for causes or effects prior to the reset, this makes it possible to conveniently and selectively reset multiple causes or effects.
(4) Override effect

Use the button of the respective effect to open the dialog for overriding the effect.

(5) Reset individual causes / effects

Use the button of the respective cause or effect to open the dialog for resetting the cause/effect. You can reset the cause or effect with this button.

(6) Open cause/effect faceplate

Use the button of the respective cause or effect to open the faceplate of the cause/effect.

(7) Filter

You can open the user interface for the filter with the button.

In the operating window of the filter, you can select whether you want to filter within the causes and effects. Depending on this setting, the filter criteria can be selected via a drop-down menu.

The following filter criteria can be set:

<table>
<thead>
<tr>
<th>Filter criterion</th>
<th>Cause:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Only numbers used in the matrix are specified as the filter value. The rows of causes only show the cause with the specified cause number. The columns of effects only show effects that have intersection points to the displayed cause.</td>
</tr>
<tr>
<td>Group</td>
<td>Only numbers used in the matrix are specified as the filter value. The rows of causes only show causes which belong to the selected group. The columns of effects only show effects that have intersection points to the displayed causes.</td>
</tr>
<tr>
<td>Alarm group</td>
<td>Only numbers used in the matrix are specified as the filter value. The rows of causes only show causes which belong to the selected alarm group. The columns of effects only show effects that have intersection points to the displayed causes.</td>
</tr>
<tr>
<td>Tag</td>
<td>Only tags used in the matrix are specified as the filter value. The rows of causes only show causes that work with the selected input tag. The columns of effects only show effects that have intersection points to the displayed causes.</td>
</tr>
<tr>
<td>Link</td>
<td>Only links used in the matrix are specified as the filter value. The rows of causes only show causes that work with the selected link. The columns of effects only show effects that have intersection points to the displayed causes.</td>
</tr>
</tbody>
</table>
Filter criterion

- **Comment**
  Any text can be entered as the filter value. The comments are checked to determine whether they contain the specified string. The rows of causes only show causes that contain the filter value in your comments. The columns of effects only show effects that have intersection points to the displayed causes.

- **Status**
  The following states can be selected as the filter value:
  - Active
  - Bypassed
  - Resettable
  - Tag active
  - Warning active
  - Tag bypassed
  - Tag QC bad
  - Tag simulated
  The rows of causes only show causes which have the selected status. The columns of effects only show effects that have intersection points to the displayed causes.

Effect:

- **Number**
  Only numbers used in the matrix are specified as the filter value. The columns of the effects only show effects with the specified effect number. The rows of causes only show causes that have intersection points to the displayed effect.

- **Number (XooN)**
  Only effect numbers of effects which are triggered by intersections with the majority principle are offered as a filter value. The columns of the effects only show effects with the specified effect number. The rows of causes only include causes that have intersection points with the majority principle for the displayed effect.

- **Group**
  Only numbers used in the matrix are specified as the filter value. The columns of effects only show effects which belong to the selected group. The rows of causes only show causes that have intersection points to the displayed effects.

- **Tag**
  Only tags used in the matrix are specified as the filter value. The columns of effects only show effects that work with the selected output tag. The rows of causes only show causes that have intersection points to the displayed effects.
Filter criterion

- **Link**
  - Only links used in the matrix are specified as the filter value.
  - The columns of effects only show effects that work with the selected link.
  - The rows of causes only show causes that have intersection points to the displayed effects.

- **Comment**
  - Any text can be entered as the filter value. The comments are checked to determine whether they contain the specified string.
  - The columns of effects only show effects that contain the filter value in your comments.
  - The rows of causes only show causes that have intersection points to the displayed effects.

- **Status**
  - The following states can be selected as the filter value:
    - Active
    - Resettable
    - Overridable
    - Bypassed
  - The columns of effects only show effects which have the selected status.
  - The rows of causes only show causes that have intersection points to the displayed effects.

The filter is enabled with the "Set" button.

The complete filter setting is deleted with the "Clear" button. If only a single row is to be deleted, the filter criterion for this row can be cleared by switching to the empty field within the drop-down menu.

The filter window is hidden with the "Close" button. Unset changes to the filter criteria are discarded.

Image 7-5  "Filter" window
**Note**

The "Status" filter function can only be used if the faceplate of Logic Matrix has been fully loaded. Only then is all the status information required for this filter function available.

You can see whether a filter is currently active based on the representation of the filter button: If the button is not set, no filter is enabled. If the button is set, a filter is enabled.

If you jump to the faceplate of the matrix using the picture navigation button of an interlock, a filter is automatically set to the effect that acts on the interlock.

**(8) Bypass**

You can use the button of the respective cause to open the dialog for setting the bypass.

![Image 7-6 Dialog for setting the bypass of a cause faceplate](image)

**(9) Display of the signal status**

This area shows you the signal status at the respective tag.

**(10) Alarm limits**

This area shows you the limit for the respective tag.

For digital tags, the limit can be ETT (energize to trip) or DTT (deenergize to trip), depending on the state in which the tag is considered to be active.

For analog tags, the area displays the analog limit with the additional information on which limit is being monitored:

- **H** - high: The displayed value is a high limit. The analog tag is enabled when the value is exceeded.
- **L** - low: The displayed value is a low limit. The analog tag is enabled when the value is violated.
- **D** - difference: The displayed value is a deviation limit. The analog tag is enabled when it deviates by more than the specified value from the other analog values.
- **G** - gradient: The displayed value is a gradient limit. The analog tag is enabled when the gradient is exceeded.
(11) Display of an additional description

This area displays the text that was specified as description in the Logic Matrix properties of the Logic Matrix Editor.

Colors of the Logic Matrix

Within the default view of the Logic Matrix, there are several areas that show the states of the causes, effects and intersections in color.

Area ① shows the state of the individual input tags. The representation is "gray" when the input tag is good, "blue" when a bypass is active for the input tag, and "red" when the input tag is "bad".

Area ② shows the state of the cause without bypass, which enables you to see the state of the cause when the bypass for the cause is disabled. The representation is "gray" if the cause is good and "red" if the cause is bad.

Area ③ shows the state of the cause. The representation is "gray" if the cause is good, "red" if the cause is bad and "blue" if a bypass was set for the cause.

Area ④ shows the state of the effect. The representation is "gray" when the effect is good, "red" when the effect is "bad" and "blue" when a bypass was set for the effect. This area can be interrupted by the state of the cause (row). The state with the highest priority is always displayed.

Area ⑤ shows the state of the effect without bypass, which enables you to see the state of the effect when the bypass is disabled. The representation is "gray" if the effect is good and "red" if the effect is bad.
Area ⑥ shows the state of the individual output tags. The representation is "gray" when the output tag is good, "red" when the output tag is "bad" and "blue" when a bypass was set for the output tag.

This is always shown in all fields with descending priority (blue > red > gray).

### 7.3.4 Preview of the matrix block

#### 7.3.4 Preview of the matrix block

**(1) Enabled operations**

This area shows all operations for which special operator authorizations are assigned. They depend on the configuration in the engineering system (ES) that applies to this block.

Symbols for enabled operations:

- **Green check mark**: The OS operator may edit this parameter
- **Gray check mark**: Editing of this parameter is temporarily disabled for the OS operator due to process conditions
- **Red cross**: The OS operator cannot control this parameter due to the configured operator authorizations

The following enabled operations are shown here:

- Cause group reset: You can perform a collective reset for the visible causes.
- Effect group reset: You can perform a collective reset for the visible effects.
- "Local operator permission": Use the ← button to switch to the standard view of the OpStations block. You can find more information on this in the Operator permissions section of the APL documentation.

### 7.3.5 Block icons for LM_Matrix

#### 7.3.5 Block icons for LM_Matrix

**Block icons for matrix**

A variety of block icons are available with the following functions:

- Process tag type
- Violation of alarm, warning, and tolerance limits as well as control system faults
• Signal status, release for maintenance
• Memo display

The block icons from template @TemplateLMV8.PDL:

<table>
<thead>
<tr>
<th>Symbols</th>
<th>Selection of the block icon in CFC</th>
<th>Special features</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon 1" /></td>
<td>1</td>
<td>Block icon with &quot;Statistics display&quot;</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon 2" /></td>
<td>2</td>
<td>Small block icon</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon 3" /></td>
<td>3</td>
<td>Invisible block icon for calling the faceplate from a custom view</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon 4" /></td>
<td>4</td>
<td>Faceplate to integrate a Logic Matrix display window in a process picture.</td>
</tr>
</tbody>
</table>

@PCS7TypicalsLM.PDL only includes the block icons 1 and 2. Block icons 1 to 4 are included in the picture @TemplateLMV8.PDL.

**Special features of the block icons**

**Icon 1 - Block icon with "Statistics display"**

The block icon displays information on:

• How many causes/effects are currently active
• How many causes/effects have a currently pending warning
• How many causes/effects are currently bypassed

**Icon 3 - Invisible block icon**

The block icon only consists of a rectangular frame that is invisible in Runtime. The size can be adjusted as desired. It is placed over a custom object and used to open the matrix faceplate with a mouse click.

**Icon 4 - Faceplate to integrate the picture window**

The block icon consists of a rectangle that is placed in the process picture with a user-definable size and position. In Runtime, the faceplate of the matrix is displayed within this rectangle when a picture is called.

**Filtering the matrix**

The block icons of the matrix have the "MatrixFilter" attribute. This attribute allows the standard view of the matrix to be opened with a pre-defined filter.

Keys and key words reflecting the filter criteria are used in order to use the attribute. The individual keywords are separated with a semicolon. The values of a key are separated with a 'pipe' symbol (|).
The cause filter is always initiated with the key `FilterType:CauseFilter`

Keywords for cause filter:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Corresponds to the filter criterion:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td></td>
</tr>
<tr>
<td>AlarmGroup</td>
<td></td>
</tr>
<tr>
<td>Tag</td>
<td></td>
</tr>
<tr>
<td>Link</td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td></td>
</tr>
</tbody>
</table>

Example: Matrix should be opened with the filter for causes 0, 1 and 2 and the alarm groups 5 and 7 according to the filter string:

- `FilterType:CauseFilter;Number:0|1|2;AlarmGroup:5|7`

The effect filter is always initiated with the key `FilterType:EffectFilter`

Keywords for effect filter:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Corresponds to the filter criterion:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>NumberXooN</td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td></td>
</tr>
<tr>
<td>Tag</td>
<td></td>
</tr>
<tr>
<td>Link</td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td></td>
</tr>
</tbody>
</table>

Example: Matrix should be opened with the filter for effects 0, 1 and 2 and the groups 5 and 7 according to the filter string:

- `FilterType:EffectFilter;Number:0|1|2;Group:5|7`
7.3.6 Standard view of the cause block

Standard view of the cause block

(1) "Reset" the settings for further processing

You can "reset" the cause with both buttons:
- "Reset cause": The cause requiring reset (12) is reset.
- "Reset initial value": First-in detection / Status display (11) is reset.

(2) Display and switch trip function

This area displays the current tripping function. The following tripping functions can be indicated here:
- OR
- AND
- XooY

The output of the function currently required to trigger the cause using degraded voting is shown below the display.

(3) Display signal status

This area displays the current signal status of the cause output.

(4) Open the faceplate of the output value

You can use the arrow to jump to the standard view of the cause's matrix.
(5) Exclude value

You can use the button (5) to exclude values from processing. Depending on the previous settings, you can "Set" or "Reset" this property.

If a value has been excluded, the following symbol appears in the field (7):

Note

The operator authorizations depend on the setting for the operator authorization of the causes in the Logic Matrix Editor.

(6) Status of the block output

The line color indicates the status of the block output:

<table>
<thead>
<tr>
<th>Color of the line</th>
<th>Output status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Cause is not active</td>
</tr>
<tr>
<td>Red</td>
<td>Cause is active</td>
</tr>
</tbody>
</table>

(7) Display the status for further processing

The symbol shows the status for further processing of the input values:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Further processing</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="https://example.com/green.png" alt="Green Icon" /></td>
<td>The input value is further processed as good.</td>
</tr>
<tr>
<td><img src="https://example.com/red.png" alt="Red Icon" /></td>
<td>The input value is further processed as bad.</td>
</tr>
<tr>
<td><img src="https://example.com/black.png" alt="Black Icon" /></td>
<td>The input value is excluded from further processing.</td>
</tr>
</tbody>
</table>

(8) Display alarm state

These fields show the alarm state with the input variable which affects the cause:

- Gray = "Good" state

Digital value:
- Alarm = "Alarm" active, input variable is passed to the logic of the cause as bad
- Discarded = The value is not used for processing.

Analog value:
- Discarded: The value is not used for processing.
- Alarm: Alarm limit of the analog value is enabled
- Deviation: Deviation is enabled for analog value
- Gradient limit: Gradient limit of the analog value is enabled
• Bad value: Value is bad due to bad signal status.
• Warning limit: Warning limit of the analog value is enabled

(9) Display input values with (10) signal status
These fields show the current input value with a signal status. The display distinguishes between digital and analog input variables.
Digital input variables indicate the current signal state as "active" or "inactive".
Analog input variables show the current analog value. If gradients are enabled for an analog value, they will be displayed below the input values. A return button for resetting the gradient is shown behind the gradient values.

(11) Open the faceplate of the output value
You can use the arrow to jump to the standard view of the block supplying the value.

(12) Display of the digital input value
A cause can have up to 3 digital input values. Each digital input value is visualized with an identical area (12) in the standard view. The number of faceplate areas depends on the number of input values configured at the cause.

(13) Display of analog input value
A cause can have up to 3 analog input values. Each analog input value is visualized with an identical area (13) in the standard view. The areas for analog input values can be displayed with or without gradient values, depending on whether or not a gradient monitoring has been activated for the value. The number of faceplate areas depends on the number of input values configured at the cause.

(14) Display area for block states
This area provides additional information on the operating state of the block:
• "First-in"

(15) Display area for block states
This area provides additional information on the operating state of the block:
• "Cause active"
7.3.7 Limit view of the cause block

Limit view of Cause

The representation of this view depends on the configuration of the cause in the Logic Matrix Editor. If no analog input values are configured for the cause, this view is empty.

(1) Deviation limits

In this area, you can enter the deviation limit for the analog input values.

You can change the following limits:

- "Deviation alarm": Deviation limit (see Analog input deviation (Page 18))
- "Hysteresis"

The display of this area depends on the configuration of the cause. If monitoring for deviation is not activated for the cause, the area is not displayed.

(2) Process value limits (display of analog input value)

In this area, you can enter the limits for the process value.

You can change the following limits:

- "Alarm": Alarm
- "Warning": Warning
- "Hysteresis": Hysteresis for process values
- "Grad H Alarm ↑": Limit of the slew rate.
- "Grad H Alarm ↓" limit of the negative slew rate.
- Hysteresis: Hysteresis for gradient deviation

Whether this involves the high (H) or low (L) limit is set in Logic Matrix Editor during configuration.

The display of this area depends on the configuration of the cause: If monitoring of the gradient is not activated for the cause, the area is not displayed. The number of displayed areas depends on the number of configured analog input tags.

(3) Suppress messages

You can enable/disable messages by setting the check mark.

(4) Message suppression / delay

Message suppression indicates if the suppression of the associated message in the AS block is activated with the \texttt{xx_MsgEn} parameter. The output of messages is not suppressed when you install the block (all \texttt{xx_MsgEn} parameters are assigned the default value 1). Messages can only be output when limit monitoring of the analog value has been enabled.

Alarm delays are also displayed in this position. For more on this, see section Area of application for alarm delays in the APL manual.

(5) Enabled operations

This area shows all operations for which special operator authorizations are assigned. They depend on the configuration in the operator authorization in the Logic Matrix Editor.

Symbols for enabled operations:

- Green check mark: The OS operator may edit this parameter
- Gray check mark: Editing of this parameter is temporarily disabled for the OS operator due to process conditions
- Red cross: The OS operator cannot control this parameter due to the configured AS operator permissions (operator authorizations in Logic Matrix Editor)
7.3.8 Parameter view of the cause block

Parameter view of Cause-Baustein

![Parameter view of Cause-Baustein](image)

(1) Time

The time for a time response configured at the cause can be set here. The display depends on the configuration of the time response for the cause in the Logic Matrix Editor.

(2) Display of the digital input value

In this area, you can make the following settings:

- "Deadband": If a deadband is configured for the digital input value, you can change it here depending on the enabled operations.
- "Simulation": Here, you can simulate the input value depending on the enabled operations. You can find information on the area in the following section of the APL manual: Simulating signals

(3) Display of analog input value

In this area, you can make the following settings:

- "Delay time": If a delay time is configured for the analog input value, you can change it here depending on the enabled operations.
- "Simulation": Here, you can simulate the input value depending on the enabled operations. You can find information on the following section of the APL manual: Simulating signals
(4) Enabled operations

This area shows all operations for which special operator authorizations are assigned. They depend on the configuration of the enabled operations in the Logic Matrix Editor that applies to this block.

Symbols for enabled operations:

- **Green check mark**: The OS operator may edit this parameter
- **Gray check mark**: Editing of this parameter is temporarily disabled for the OS operator due to process conditions
- **Red cross**: The OS operator cannot control this parameter due to the configured operator authorizations.

7.3.9 Preview of the cause block

Preview of Cause

(1) Time

The time for a configured time response at the cause is displayed here.

The display depends on the configuration of the time response for the cause in the Logic Matrix Editor.

(2) Analog process value area

The real process value ($PV$) of an analog input value is displayed.

A cause can have up to 3 analog input values. Each analog input value is visualized with an identical area (2).
(3) Digital process value area
The real signal state of a digital input value is displayed.
A cause can have up to 3 digital input values. Each digital input value is visualized with an identical area (3).

(4) Enabled operations
This area shows all operations for which special operator authorizations are assigned. They depend on the configuration of the operator authorization in the Logic Matrix Editor that applies to this block.

Symbols for enabled operations:
- **Green check mark**: The OS operator may edit this parameter
- **Gray check mark**: Editing of this parameter is temporarily disabled for the OS operator due to process conditions
- **Red cross**: The OS operator cannot control this parameter due to the configured operator authorizations

The following enabled operations are shown here:
- Bypass cause: You may set the bypass for the cause.
- Reset first in: You can reset the initial value of the cause.
- Reset cause: You can reset the cause
- "Local operator permission": Use the ← button to switch to the standard view of the OpStations block.
- Bypass analog/digital value: You may set the bypass for the input value.
- Reset gradient: You can reset the peak value of the gradient for the analog input value.

7.3.10 Standard view of the effect block

Standard view of the matrix block
(1) Exclude value

You can use the button (1) to exclude a value from processing. Depending on the previous settings, you can "Set" or "Reset" this property.

If a value has been excluded, the following symbol appears instead of the point on the line:

Note

The operator authorizations depend on the setting for the operator authorization of the causes in the Logic Matrix Editor.

(2) Override value

You can override the effect with the button (2). Depending on the previous settings, you can "Set" or "Reset" this property.

If a value has been overridden, the following symbol appears instead of the point on the line:

Note

The operator authorizations depend on the setting for the operator authorization of the causes in the Logic Matrix Editor.

(3) Status of the block output

The line color indicates the status of the block output.

<table>
<thead>
<tr>
<th>Color of the line</th>
<th>Output status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Effect is not active</td>
</tr>
<tr>
<td>Red</td>
<td>Effect is enabled</td>
</tr>
</tbody>
</table>

The display can be divided into two parts:

The line up to the action point for a bypass and override shows the actual status of the effect. The line after the action point show the value that is generated.

(4) Open the faceplate of the output value

The arrow opens an expanded view in which all output variables acting on the effect are displayed.

You can use the buttons in the expanded view to jump to the standard view of the technological block belonging to the output variable.
(5) Display signal status

This area displays the current signal status of the effect output.

(6) Display trip function

This area shows the trigger function of the effect.

The is a display for each type of node here. You can thus recognize which type of node triggered the effect.

- N: Non-stored
- S: Stored
- V: Overridable
- R: Resettable and overridable

(7) "Reset" the settings for further processing

You can use the button to "reset" the triggering criteria of the effect requiring reset.

(8) Display area for block states

This area provides additional information on the operating state of the block:

- Override warning
- Override active
- "Time limited Override"

(9) Display area for block states

This area provides additional information on the operating state of the block:

- "Delay active"

(10) Multi-nodes

If the effect is activated by a multi-node, information on the state of the multi-node is available in this field.

(11) Open the faceplate of the matrix

You can use the arrow to jump to the standard view of the effect's matrix.
7.3.11 Parameter view of the effect block

Parameter view of motors and valves

![Image of parameter view]

(1) Times

In this area, you can change times and thereby influence the time response. The display depends on the configuration of the time response for the cause in the Logic Matrix Editor.

You can influence the following parameters:

- **Override time**: The amount of time for which the effect should be overridden when override has been activated.
- **Pre-warning time**: Time before stopping an override with the override time at which a warning message should be generated.
- **Time**: The time for a time response configured at the cause can be set here.

(2) Enabled operations

This area shows all operations for which special operator authorizations are assigned. They depend on the configuration of the enabled operations in the Logic Matrix Editor that applies to this block.

Symbols for enabled operations:

- **Green check mark**: The OS operator may edit this parameter
- **Gray check mark**: Editing of this parameter is temporarily disabled for the OS operator due to process conditions
- **Red cross**: The OS operator cannot control this parameter due to the configured operator authorizations.
7.3.12 Preview of the effect block

Preview of MonAnL

(1) Time

The time configured at the cause is displayed here.
The display depends on the configuration of the time response for the effect in the Logic Matrix Editor.

(2) Enabled operations

This area shows all operations for which special operator authorizations are assigned. They depend on the configuration of the operator authorization in the Logic Matrix Editor that applies to this block.

Symbols for enabled operations:

- **Green check mark**: The OS operator may edit this parameter
- **Gray check mark**: Editing of this parameter is temporarily disabled for the OS operator due to process conditions
- **Red cross**: The OS operator cannot control this parameter due to the configured operator authorizations

The following enabled operations are shown here:

- Override effect: You may enable the override for the effect
- Bypass effect: You may set the bypass for the effect.
- Reset effect: You can reset the effect
- "Local operator permission": Use the ← button to switch to the standard view of the OpStations block.
7.3 Block icon and faceplates
Index

A
Active, 13
Adding and editing a cause, 56
Adding and editing an effect, 63
alternative, 34, 73
Assignment of functions to user permissions, 53

B
Block icon
  Matrix, 117
Bypass, 14

C
Cause, 12
  Alarms, 62
  Creating/changing, 56
  Digital parameters, 62
Cause block
  Limit value view, 123
  Standard view, 120
Cause details
  Alarms, 62
  Analog parameters, 60
  Configuration, 58
  Digital parameters, 62
Cause-Baustein
  Parameter view, 125
Changing limit, 60
Changing the hysteresis, 61
Column for effect, 63
Compiling and downloading to the OS, 105
Compiling the SIMATIC-Project, 104
Configuration and data storage, 105
Configuration areas of the Logic Matrix user interface, 42
Connection, 73

D
Deenergize-to-trip (DTT), 14
Downloading the SIMATIC project to the CPU, 104
DTT, 14

E
Editing authorization levels, 53
Effect, 12
  Creating/changing, 63
Effect details
  Configuring, 64
  Operation levels, 65
Energize-to-trip (ETT), 13
ETT, 13
Exporting
  Logic Matrix, 79
Exporting a Logic Matrix, 78

F
Function type, 13

I
Importing
  Logic Matrix, 100
Importing a Logic Matrix, 78
Inactive, 13
Installing
  Requirements, 37
Intersection, 13
  Editing/changing, 76
Intersection assignment according to the majority principle, 77

L
Link, 13
  alternative, 34, 73
Logic Matrix
  Add input, 47
  Add output, 48
  Creating cause, 47
  Creating effect, 48
  Creating link, 47
  Exporting, 79
  Importing, 100
  Inserting, 41
  Menu commands, 43
  Object, 41
Index

Optional packages, 12
Order numbers, 3
Range of functions, 12
User interface, 42

Standard view
  Cause block, 120
  Matrix block, 110, 127

T
  Transferring, 103
  Transferring changes in a Logic Matrix to the OS, 105

V
  Validity, 72
  Views
    Matrix, 108

M
  Matrix
    Block icon, 117
    Preview, 117
    Views, 108

  Matrix block
    Standard view, 110, 127

Menu commands, 43
MonAnL
  Preview, 126, 131

O
  ods file, 78
    Exporting, 79
    Importing, 100

Operator control and monitoring
  Overview of the functions, 54
  Requirements, 107
  User permissions, 53

Optional packages, 12

P
  Parameter view
    Motor, 130
    Project structure, 45
    Properties
      Properties, 50

R
  Requirements for configuration, 45
  Rows for cause, 56

S
  Shortcut menu
    Cause, 56
    Effect, 63, 64
    Intersection, 76
  Special circumstances when downloading in the case of single-user systems, 105

Logic Matrix
Configuration Manual, 01/2016, A5E35886614-AA